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Notices 

Copyright 
Copyright © 2017 Quantum Northwest, Inc. All 
rights reserved.  

All copyright, confidential information, patents, 
design rights and all other intellectual property 
rights of whatsoever nature contained herein are 
and shall remain the sole and exclusive property 
of Quantum Northwest, Inc. The information 
furnished herein is believed to be accurate and 
reliable. However, no responsibility is assumed by 
Quantum Northwest, Inc. for its use, or for any 
infringements of patents or other rights of third 
parties resulting from its use. 

The Quantum Northwest name, QNW acronym 
and Quantum Northwest logo are trademarks or 
registered trademarks of Quantum Northwest, Inc.  
All other trademarks are the property of their 
respective owners. 

Quantum Northwest products must only be used 
in the manner described in the Quantum 
Northwest product user guides.  Any other use 
may result in damage to the product or personal 
injury.  Quantum Northwest is not responsible for 
any damages caused, in whole or in part, by 
improper use of the products, unauthorized 
alterations, adjustments or modifications to the 
products, failure to comply with procedures in 
Quantum Northwest product user guides, or use 
of the products in violation of applicable laws, 
rules or regulations.  Quantum Northwest shall not 
be liable for errors or damages on products or 
performance due to using non-Quantum 
Northwest genuine parts.  

Warranty  
The material contained in this document is 
provided “as is,” and is subject to being changed, 
without notice, in future editions. Further, to the 
maximum extent permitted by applicable law, 
Quantum Northwest disclaims all warranties, 
either express or implied, with regard to this 

manual and any information contained herein, 
including but not limited to the implied warranties 
of merchantability and fitness for a particular 
purpose. Quantum Northwest shall not be liable 
for errors or for incidental or consequential 
damages in connection with the furnishing, use, or 
performance of this document or of any 
information contained herein. Should Quantum 
Northwest and the user have a separate written 
agreement with warranty terms covering the 
material in this document that conflict with these 
terms, the warranty terms in the separate 
agreement shall control.  

Technology Licenses  
The hardware and/or software described in this 
document are furnished under a license and may 
be used or copied only in accordance with the 
terms of such license. 

Safety Notices 

CAUTION  

A CAUTION notice denotes a hazard. It calls 
attention to an operating procedure, practice, or 
the like that, if not correctly performed or adhered 
to, could result in damage to the product or loss of 
important data. Do not proceed beyond a 
CAUTION notice until the indicated conditions are 
fully understood and met. 

WARNING  

A WARNING notice denotes a hazard. It calls 
attention to an operating procedure, practice, or 
the like that, if not correctly performed or adhered 
to, could result in personal injury or death. Do not 
proceed beyond a WARNING notice until the 
indicated conditions are fully understood and met. 
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1. General Information 
Thank you for purchasing a Quantum Northwest qCHANGER 6. We want you to enjoy many years of faithful 
service from your instrument. If you have any questions, feel free to contact us directly through our website, 
www.qnw.com/contact-us/, or by email at service@qnw.com. 

Your Quantum Northwest cuvette holder and accessories have been carefully designed so that when used 
properly, you have an accurate, fast, flexible and safe temperature control system.  

Information about safety practices appears throughout the documentation provided with your instrument and 
accessories to help you safely operate the instrument and accessories. Before using the instrument or 
accessories, you must thoroughly read these safety practices. ALWAYS operate the instrument and 
accessories in accordance with these safety practices. 

1.1. User Documentation 
You have been provided with the following documentation to help you set up and operate your Quantum 
Northwest qCHANGER 6 cuvette holder:  

 This manual, with safety practices and hazards information, instructions for installing and maintaining 
the components of the qCHANGER 6, and troubleshooting information. 

 The T-App Help file, located on the T-App CD (Quantum Northwest>T-App Help), if purchased.  
Elements of the T-App Help file are presented in Section 12 of this user guide. 

1.2. Modules, Covers and Panels 
The spectrophotometer module that operators and other personnel will routinely access is the instrument’s 
sample compartment, which is designed to contain the QNW qCHANGER 6. Customers may insert cuvettes 
and cuvette accessories into the QNW qCHANGER 6 while the sample compartment is open. 

Any other panels or covers that are retained by screws on the cuvette holder and accessories may be 
opened ONLY by Quantum Northwest service technicians. 

1.3. Other Precautions 
Do not block any ventilation grills present on the QNW TC 1 Temperature Controller. 

Use of the QNW qCHANGER 6 system and accessories may involve materials, solvents and solutions that 
are flammable, corrosive, toxic or otherwise hazardous. Careless, improper, or unskilled use of such 
materials, solvents and solutions can create explosion hazards, fire hazards, toxicity and other hazards which 
can result in death, serious personal injury, and damage to equipment and property.  

ALWAYS ensure that laboratory safety practices governing the use, handling and disposal of such materials 
are strictly observed. These safety practices should include the wearing of appropriate safety clothing and 
safety glasses. 
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1.4. Warning and Other Symbols 
The following is a list of symbols that appear in conjunction with warnings on the QNW cuvette holder and 
accessories. The hazard they describe is also shown.  

A triangular symbol indicates a warning. The meanings of the symbols that may appear alongside warnings in 
the documentation or on the instrument itself are as follows.  

 

 

When used on a warning label, the user is in 
danger of an electrical shock. 

 

When used on warning labels attached to the 
instrument, refer to the relevant operation or 
service manual for the correct procedure referred 
to by that warning label. 

 

When attached to the rear of the instrument, 
indicates that the product complies with the 
requirements of one or more EU directives. 

 

1.5. CE Compliance 
Your QNW qCHANGER 6 cuvette holder has been designed to comply with the requirements of the 
Electromagnetic Compatibility (EMC) Directive and the Low Voltage (electrical safety) Directive (commonly 
referred to as the LVD) of the European Union. Quantum Northwest has confirmed that each product 
complies with the relevant Directives by testing a prototype against the prescribed EN (European Norm) 
standards.  

Proof that a product complies with these directives is indicated by:  

 the CE Marking appearing on the rear of the product, and  

 the following Declaration of Conformity. The Declaration of Conformity is the legal declaration by 
Quantum Northwest that the product complies with the directives listed above, and shows the EN 
standards to which the product was tested to demonstrate compliance.  
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EU Declaration of Conformity 

 

We:    Quantum Northwest, Inc. 

Of:    22910 E Appleway Ave, Suite 4 

    Liberty Lake, WA 99019‐8606 

    USA 

Hereby declare under our sole responsibility that the following devices: 

QNW MODEL (CONTROLLER MODEL) 

BATH 10 

CD 250™ (TC 1 Controller) 

FLASH 300™ (TC 1 Controller) 

Luma 40™ (TC 1 Controller) 

qCHANGER 6 (TC 1 Controller) 

qpod® (TC 1 Controller) 

t2 Sport™ (TC 1 Controller) 

t2x2 Sport™ (TC 1 Controller) 

Turret 4™ (TC 1 Controller) 

Turret 6™ (TC 1 Controller) 

Versa 20™ (TC 1 Controller) 

 

Comply with the essential requirements of the following applicable European Directives: 
Electromagnetic Compatibility (EMC) Directive 2004/108/EC,  

General Product Safety Directive 2001/95/EC 

Low‐Voltage Directive 2014/35/EU,  

RoHS Directive 2011/65/EU. 

Conformity is assessed in accordance to the following standards: 
EMC Directive:    Emissions  EN 61326‐1 (2013)  Group 1  Class A  

Immunity   EN 61326‐1 (2013)  Group 1  Class A  

Low Voltage Directive:  Safety    EN 61010‐1 (2011) 

I hereby declare that the equipment models named above have been assessed and found to comply with 
the relevant sections of the above‐referenced specifications.  The units comply with the relevant 
requirements of the applicable Legislation, and I am the person authorized to compile the technical 
documentation. 
 
 

Signed by:   

Name:    Enoch W. Small, Ph.D. 
Position:  President, Quantum Northwest, Inc. 
Date:    September 21, 2016 
Location:  Liberty Lake, Washington, USA 
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Declaration of Conformity to EU Directive 2011/65/EU (RoHS) 

 
We:    Quantum Northwest, Inc. 
Of:    22910 E Appleway Ave, Suite 4 
    Liberty Lake, WA 99019‐8606 
    USA 
 
Declare under our sole responsibility that our products indicated below are in fully compliance with EU 
Directive 2011/65/EU, with respect to the following substances: 

1. Lead (Pb), 
2. Mercury (Hg), 
3. Cadmium (Cd), 
4. Hexavalent chromium (Cr (VI)), 
5. Polybrominated biphenyls (PBB), 
6. Polybrominated diphenyl ethers (PBDE), Deca‐BDE included. 

QNW MODEL (CONTROLLER MODEL) 

BATH 10 

CD 250™ (TC 1 Controller) 

FLASH 300™ (TC 1 Controller) 

Luma 40™ (TC 1 Controller) 

qCHANGER 6 (TC 1 Controller) 

qpod® (TC 1 Controller) 

qpod® 2e (Integrated Control) 

t2 Sport™ (TC 1 Controller) 

t2x2 Sport™ (TC 1 Controller) 

TLC 50 Legacy (TC 125 Controller) 

Turret 4™ (TC 1 Controller) 

Turret 400 Legacy (TC 425 Controller) 

Turret 6™ (TC 1 Controller) 

Versa 20™ (TC 1 Controller) 

 
The following statement regarding conformity of our products to the EU Directive 2011/65/EU (RoHS) is 
based on our actual research and inquiries with our suppliers: 

All products sold under the above model numbers previously, currently and in future are/will be 
fully compliant with EU Directive 2011/65/EU and without exemption. 

 

Signed by:   

Name:    Enoch W. Small, Ph.D. 
Position:  President, Quantum Northwest, Inc. 
Date:    September 21, 2016 
Location:  Liberty Lake, Washington, USA 
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2. Specifications 

 

 

Figure 1. qCHANGER 6 Cuvette Holder Figure 2. TC 1 Temperature Controller 

2.1. Introduction: QNW qCHANGER 6 Cuvette Holder with 
TC 1 Temperature Controller 

Intended Use 

The QNW qCHANGER 6 Cuvette Holder is designed to be inserted into a commercially-available 
spectrophotometer, replacing the sample cuvette holder originally supplied with the instrument.  The movable 
body of the qCHANGER 6 has a temperature-controlled metal core that holds up to six cuvettes, and comes 
with the TC 1 Temperature Controller to control cuvette temperature during optical measurements.  
Temperature control is achieved using the TC 1 Temperature Controller alone or along with a computer 
interfaced to the TC 1 Temperature Controller box, using the QNW T-App software available for purchase. 

Specifications 

 Temperature range   -15 to +110 °C 

 Temperature precision   ±0.02 °C 

 Temperature accuracy   ± 0.25 °C from -20 °C to + 110 °C 

 Temperature reproducibility  better than ±0.12 °C 

 Magnetic stirring   1 to 2500 rpm precisely set 

 Cuvette size (outside dimensions) 12.5 x 12.5 mm 

 Minimum cuvette height   30 mm 

 Optical port dimensions   11 mm high x 10 mm wide 

 Probes accepted   Series 400 or Series 500 

 Cuvette z-height   15 mm 
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Note:  The “z-height” of a cuvette is the distance between the bottom outside 
surface of the cuvette and the designed position for the optical center line, where 
the incident beam of light strikes the cuvette. The z-height for a typical 
microcuvette is shown to the right. 

2.2. Measurement Category 
The measurement category is IEC 61010:I. Do not to use this equipment for measurements within 
measurement categories II, III and IV. 

2.3. Pollution Degree 
The pollution degree is IEC61010:2. Pollution degree “2” applies to a normal indoor atmosphere. 

2.4. Overvoltage Category 
The overvoltage category (installation category) is CAT II. See IEC 664 & IEC 61010. 

2.5. Environmental Conditions 
The area should have a dust-free atmosphere with minimal drafts, vibrations, and corrosive fumes. For 
optimum performance, the ambient air is recommended to be between 20 and 25 °C, but can be from 5 to 40 
°C. Relative humidity should be less than 80%. The instrument is designed for operation at 2,000 m elevation 
or less. 

To avoid damage through spillage of solutions and samples being analyzed, the worktops should be covered 
with a material that is corrosion resistant and impervious to liquids.  

Allow at least two inches of space on both sides, and six inches at the rear of the TC 1 temperature controller 
to permit free air circulation. The power cord and all other connections are located at the rear of the 
instruments. The power switch is located on the rear panel.  

2.6. Electrical Specifications 

Mains Supply 

A standard power cable is provided based on the user’s country requirements (18 AWG/115 V AC 
US/Canada; 1.0 mm/220 V AC international). The required supply voltage is 100-240 V AC (frequency 50 or 
60 Hz). The mains voltage fluctuations must not exceed 10% of the nominal voltage. 

The installation of electrical power supplies must comply with the rules and/or regulations imposed by local 
authorities responsible for the supply of electrical energy to the workplace. 

All power supplies for the TC 1 Temperature Controller must be single-phase, AC voltage, three-wire system 
(active, neutral, earth) and should be terminated at an appropriate power outlet receptacle that is within reach 
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of the power cord. For safety reasons, a separate power outlet receptacle should be provided for each unit in 
the system. The use of extension cords or outlet adaptors is not recommended. 

 

WARNING  

Shock Hazard - Danger of electrocution. Good electrical grounding is essential to avoid 
potentially serious shock hazards. A 3-wire outlet with ground connection must be provided for 
the qCHANGER 6. Make certain that power outlets are earth-grounded at the grounding pin.  

 

CAUTION 

 

Caution - Never connect or disconnect any cables while the qCHANGER 6 /TC 1 Temperature 
Controller is switched on. Damage to the printed circuit boards may occur. 

 

2.7. Computer Requirements 
A computer is required only if T-App software has been purchased. 

The T-App temperature application software used for external control of Quantum Northwest temperature 
controllers requires a personal computer using a Microsoft Windows™ operating system (XP, Vista, 7, 8 or 
10). The T-App software is normally provided on a CD, requiring a CD player be part of the computer. 
However, T-App may also be downloaded via the Internet from a link provided by QNW.  Contact QNW 
should you wish to obtain the application by Internet. 
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3. Installing, Starting and Stopping the QNW 
qCHANGER 6 – a Quick Start Guide 

3.1. Installing the QNW qCHANGER 6 

Unpacking 

After accepting delivery, take the equipment to the installation site. Quantum Northwest instruments are 
inherently robust, and the packaging is designed to prevent internal damage. However, the contents form part 
of a precision measuring system and all packages should be handled with care. In transit, sharp jolts must be 
avoided and the packages should not be inverted or tilted unnecessarily. Markings on the shipping cartons 
generally indicate which side of the package should be kept on top.  

Note:  The qCHANGER 6 may have been already installed in the spectrophotometer by its 
manufacturer. 

Unpacking the equipment is your responsibility. As the packages are opened, ensure that you have received 
everything you ordered. If there are any discrepancies, notify the supplier. If any items are found to be 
damaged, immediately notify the carrier and supplier.   

You should have received:  

 1x qCHANGER 6 Temperature-Controlled Cuvette Holder 

Note:  The qCHANGER 6 may come attached to a front panel designed to replace the front panel 
of the destination spectrophotometer. 

 1x TC 1 Temperature Controller 

 1x power cable 

 1x USB or RS-232 (9-pin serial) cable 

 1x “V-cable” assembly with one DB25 (25-pin) connector at one end and two DB15 (15-pin) 
connectors at the other 

 1x BATH 10 Submersible Pump and Bucket  

 6x magnetic stir bar 

 1x -inch diameter vinyl tubing to connect water 

 1x -inch diameter vinyl tubing to connect gas 

 1x -inch-to--inch barbed reducer fitting 

 This manual 

Note:  Any additional accessories ordered are not listed here. 

Any differences from the original order should be referred immediately to your Quantum Northwest sales 
office. Do not discard any packaging components or filler materials. 
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Installing the QNW T-App Software (if purchased) 

CAUTION 

 

Caution - Install T-App software before connecting the TC 1 to your computer.  Software 
installation installs a driver. If the TC 1 Temperature Controller is connected to the computer and 
turned on before software installation, then the computer may automatically load an incorrect 

driver that may be difficult to remove. 

 

1. Follow the instructions provided with the software to complete the installation. The instructions are 
found in a text file titled “Instructions.txt” within the T-App folder. Those instructions will be similar to 
the following: 

 

Instruction for installation of T-App 

1. Copy the "T-App" folder to a convenient location on the computer to be used. 

2. Run "CDM v2.12.12 WHQL Certified.exe" to the install drivers needed for serial 
communications between the QNW TC 1 temperature controller and the T-App application. 

3. Connect the TC 1 to the computer to be used with the USB cable provided with the TC 1 (or 
any USB cable with the correct plug ends).  Turn on the TC 1 power.  Installation of the drivers for 
the USB connection should begin immediately and proceed automatically. 

4. Run "T-App.exe".  For further information select the Help>(T-App Help) menu item. 
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Installing the QNW qCHANGER 6 Hardware 

Figure 3. A qCHANGER 6 comes in many configurations, depending on the spectrophotometer in which it 
is to be installed. Each configuration has a base plate. Some configurations also have a front panel, 
designed to replace the front panel of the destination spectrophotometer. 

Note:  The qCHANGER 6 may have already been installed into the destination spectrophotometer 
by its manufacturer. In this case, it is necessary only to make the appropriate connections 
described in Step 2 below. 

1. Remove the existing sample tray from the spectrophotometer. Install the qCHANGER 6 with its 
attached base plate(s) (and front panel, when included) into the sample compartment and secure it in 
place. 

2. Connect the DB25 connector end of the “V-cable” to the 25-pin connector at the qCHANGER 6 
(either mounted at the front panel, if there is one, or attached by cable to the device). Connect the 
two DB15 cables at the other end of the “V-cable” connected to the qCHANGER 6 to the back of the 
TC 1 temperature controller, matching the appropriate cable ends to those on the TC 1 connectors.   

Note:  Be careful not to over-tighten the screws to avoid stripping the threads. 

 
CAUTION 

 

Caution - Never connect or disconnect any cables while the qCHANGER 6 /TC 1 Temperature 
Controller is switched on. Damage to the printed circuit boards may occur. 

 

3. Connect a long length of -inch tubing from each “water” hose barb on the qCHANGER 6 (shown in 
Figure 4) to the lowest position of the coolant water bucket (often at floor level). Each length of tubing 
may be cut from the supply of -inch tubing provided with the qCHANGER 6. Note that in Step 5, one 



 

 

  3/22/2017  
  

Page 16 of 73 

QNW qCHANGER 6 User’s Guide

length will be connected to the BATH 10 submersible pump, while the other end will hang free in the 
coolant water bucket. 

4. Check that the TC 1 power switch in the back is in the off position. Plug the power cable into the back 
of the TC 1 Temperature Controller and into a wall socket. (The TC 1 will accept AC voltages from 
100 to 240 at 50 or 60 Hz.) 

Note:  Leave the power off. 

 

Figure 4. A front panel for one 
version of qCHANGER 6 showing 
external connectors for the two water 
lines and one gas line, and the DB25 
cable. Not all front panels look like 
this one, and not all qCHANGER 6 
versions include a front panel. The 
use of dry gas is optional unless 
operating below the dew point (~5 
˚C). 

 

 

Figure 5. Submersible pump, bucket, electrical 
cable, and vinyl tubing supply for the qCHANGER 6 

5. Connect one of the two long lengths of vinyl tubing described in Step 3 to the barb connector on the 
submersible pump provided. It does not matter which of the two long lengths of vinyl tubing is 
chosen. 

6. Fill the reservoir bucket at least half full of cold distilled or deionized water and set the submersible 
pump into it. An algaecide may be added to prevent algal growth over time. Position the bucket to 
within 75 cm (30 in) higher or lower than the spectrophotometer. 
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CAUTION 

 

Caution – Position the bucket in a location that minimizes the risk of spilling the liquid contents. 

 

 

7. Position the free end of the other length of tubing described in Step 3 in (or above) the water in the 
bucket. This piece of tubing serves as the return tubing for water returning to the reservoir.   

Note:  Secure the two pieces of tubing together with a twist-tie to make it unlikely that the return 
tubing does not accidently get dragged out of the bucket. 

 

Note:  The water in the bucket should be changed frequently (e.g., weekly) to avoid bacterial and 
algal growth. 

8. Connect the power connector from the submersible pump to the matching socket on the back of the 
TC 1 Temperature Controller. 

9. Turn on the power to the TC 1 using the switch on the back of the TC 1 unit. On the TC 1 front panel, 
press once on the right-arrow button and once on the SET button. These two steps turn on the pump 
by turning on the temperature control. (The pump runs only when the temperature control is turned 
on.1)   

10. Check for leaks in the system. 

11. Check that water is flowing from the free tubing end. If it does not, lift the pump off the bottom of the 
bucket, but not out of the water, and drop it. This usually will get the flow started. If it does not after 
several tries, lift the pump up close to the water surface and let a small drop of liquid detergent land 
in the water close to the pump intake. 

12. For now, turn the TC 1 power off. 

 

                                                      
1 In fact, the pump will stay on when the temperature control has been turned off if the pump had been turned 
on using the T-App command [F1 PP +]. 
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Figure 6. An example of a qCHANGER 6 holding six cuvettes, with the ring of the cuvette lifter to the right 
of the cuvettes. Position 6 of the six cuvettes is immediately adjacent to the cuvette lifter. (Position 1 is at 
the opposite end, with the remaining positions sequentially in between.) It is not necessary to use all six 
positions when using the qCHANGER 6. 

 

13. OPTIONAL - If you plan to work at low temperatures, connect a source of dry gas, typically nitrogen, 
to the small hose barb labeled “gas” on the front of the cuvette holder assembly.  It is very important 
to use dry gas flow when working at temperatures below the dew point, approximately 5 °C.  Not only 
will the dry gas prevent condensation on the cuvette windows, but it will also prevent condensation in 
the interior of the qCHANGER 6 cuvette holder.  Use the length of -inch tubing provided (a - to -
inch barbed reducer fitting is also provided).  Set the dry gas flow rate to about 50 cc/min. 

 
CAUTION 

 

Caution – When using dry gas to prevent condensation on the cuvette, ensure that the working 
area is adequately ventilated. Always secure the gas tank to a solid object. Never put water 
through the gas line. 

 

3.2. Starting the QNW qCHANGER 6 

1. Place a magnetic stir bar in a standard 10 x 10-mm square cuvette. Insert a liquid sample into the 
cuvette. 
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2. Place the cuvette in the qCHANGER 6 cuvette holder, position 1 (or other position as desired). See 
Figure 6. Gently nudge the cuvette in the direction away from the cuvette lifter ring in order to ensure 
that the cuvette is properly seated in its holder. 

3. Repeat Steps 1 and 2 for other cuvettes and other positions of the qCHANGER 6 cuvette holder. 

4. OPTIONAL - If you wish to monitor the temperature inside a cuvette, plug a standard Series 400 or 
Series 500 thermistor probe (not provided) into the ¼ - inch phone jack labeled “probe” in the back 
panel of the TC 1.  Place the end of the probe in a region of the liquid in the cuvette where it will not 
occlude the spectrometer light beam. 

5. Turn on the TC 1 controller using the power switch on the back panel. 
 

 

 

       

TC 1 Front panel Menu Control Buttons 

6. Use the left, right, up and down arrows on the front panel Menu Control Buttons, shown above, to 
cycle through the controller options.  These options are described in detail in Section 4.2 below.  To 
simply set a temperature, and turn on magnetic stirring, press the right arrow once to go to the Set 
Target Temp. page and use the up and down arrows to set a target temperature, say 37.0 °C.  Press 
SET to initiate temperature control and seek this temperature.  The temperature of the cuvette holder 
will change and stabilize at the new target value.  Next, press the right arrow twice to go to the Set 
Stirring page.  Use the up and down arrows to set a speed, say 1200 rpm, and press SET to start 
the stirrer(s).  For more detailed use of the menu button, including temperature ramping, see Section 
4.2 below. 

3.3. Stopping the QNW qCHANGER 6 

1. To turn off temperature control, press the right arrow on the TC 1 Menu Control Buttons once to go to 
the Set Target Temp. page, then press SET again.  To turn off stirring, go to the Set Stirring page 
and press SET again. 

2. After measurements are completed, turn off power on the back of the TC 1 controller. This action will 
turn off both the TC 1 and the submersible pump. If you are using a circulator pump other than that 
provided with the qCHANGER 6, remember to turn it off also. 
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4. Step-by-Step Instructions for Using the 
QNW qCHANGER 6 

4.1. Instrument Overview 
The movable body of the qCHANGER 6, shown in Figures 1 and 6, has a temperature-controlled metal core 
that holds up to six cuvettes. A Peltier element is sandwiched between this core and a brass heat exchanger.  
Water flows through the heat exchanger to draw off heat generated when the temperate of the cuvette holder 
is lowered. The water also provides heat when the temperature is raised. Two tubes of -inch inside diameter 
are used to conduct the cooling water. The core is surrounded by a thermally insulating, molded plastic cover. 
A cuvette lifter can be used to lift the cuvettes a few millimeters to make them easy to remove. 

Note:  Cuvettes must be taller than 30 mm, or they will pass below the metal clip and become 
stuck. 

The qCHANGER 6 holds standard cuvettes with outside dimensions of 12.5 x 12.5 mm. A metal clip and 
spring plunger assembly is used to push each cuvette into one of the corners of its individual space for 
reproducible positioning and to favor heat transfer. For each cuvette, the wall opposite the metal clip is 
relieved to prevent scratching of the cuvette surface. 

The body of the qCHANGER 6 rides on two precision ground stainless rods, and moved by a stepper motor 
and screw drive. A miniature stepper motor resides under each cuvette to drive a rotating magnet. Dry gas 
enters a -inch hose barb on one end of the body and is carried through a manifold in the floor of the device 
to small holes on the bottom of the cuvette windows. This flow of gas keeps the windows free of 
condensation when working below the dew point temperature. 

Two wires are brought back from the qCHANGER 6 to the TC 1 temperature controller.  One conducts the 
drive currents for the main stepper motor drive and the six individual stepper motors used for magnetic 
stirring.  The other conducts the sensor lines and power for the Peltier unit. 

T-App is a computer program (purchased separately) that permits external computer control of the TC 1 
Temperature Controller. The temperature of the cuvette holders and a temperature sensed by an external 
probe may be plotted vs time. Simple text scripts may be used to automate multiple-step operations. T-App 
may be used with a USB cable to connect your computer to the TC 1. Full instructions for using T-App may 
be found in the associated Help file, sections of which are provided in Section 12.  Examples of scripts are 
found in Section 13. 

4.2. Detailed Instructions 

Using the front panel Menu Control Buttons 

 

 
Figure 7. The Menu Control Buttons (SET, left arrow, right 
arrow, up arrow, and down arrow) on the front panel of the 
TC 1 controller allow full functionality without an external control 
program. 
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The Menu Control Buttons allow control of temperature, magnetic stirring, ramping and cuvette position for 
the qCHANGER 6. 

Right after the power has been turned on, temperature control will be off with the target temperature (TT) set 
to 20 °C. Stirring will be off, with the stirring rate set to 1200 rpm (the default setting when stirring is turned 
on). Ramping will be off with the ramp rate set to 0.50 °C/min (the default setting when ramping is turned on). 
The cuvette position will be set to Position 1. 

The relationships between the different front panel display screens are summarized in Figure 8. The text in 
the display screens is that which will be seen for about 5 seconds after the TC 1 power has been turned on. 
In Figure 8, the room temperature is 22.9 °C at the time of TC 1 power-up, so the holder temperature shows 
that value. The "Probe = " line will be shown only if an optional temperature probe has been plugged into the 
TC 1. 

 

Using the TC 1 Temperature Controller 

When first powered on, the QNW COPYRIGHT display will appear for about 5 seconds before it is replaced 
by the MAIN display. 

 
 
When the MAIN display is shown, pressing the blue down arrow causes the QNW COPYRIGHT display to 
reappear for about 5 seconds before the display returns to MAIN again. 

The MAIN display will reflect the current experimental settings being used. Several combinations are 
illustrated below. 

 

       

      No probe, ramping off,           With probe, ramping in “wait      With probe, actively ramping, 
               stirring off.                    for new TT” mode, stirring off.                    stirring on. 

 

The “Holder = ” line gives the current temperature of the cuvette holder. 

The “Target = ” line gives the current target temperature (TT) setting. When temperature control is on, the 
holder temperature will be converging on the TT, and the green LED near the upper right corner of the 
display will be blinking slowly. When the holder temperature reaches the TT and has stayed within a range of 
TT ± 0.05 °C for 1 minute, the green LED will stop blinking and stay on. 

The “Probe  = ” line is the temperature registered by an optional series 400 or 500 thermistor probe plugged 
into the external probe socket in the back of the TC 1. 

An external control program such as T-App can set the controller to locked mode, which will cause the text 
“LOK” to appear in the parameter setting screens. In locked mode, the TC 1 controls for changing the settings 
(up arrow, down arrow, SET) will have no effect. Under these conditions, changes are possible only through 
the external control program. 

Holder = 22.9°C  POS 
Target = 20.0°C    1 
Probe  = 23.0°C 
Ramp Off Stir Off 

Holder = 22.9°C  POS 
Target = 20.0°C    1 
 
Ramp Off Stir Off 

Holder = 36.9°C  POS 
Target = 37.0°C    1 
Probe  = 36.2°C 
Ramp wTT Stir Off 

Holder = 73.4°C  POS 
Target =100.0°C    1 
Probe  = 98.7°C 
Ramp On  Stir On 
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Example of using the Menu Buttons for control of the TC 1 

In the default mode (after power is first turned on), the TC 1 parameters are: 
 temperature control is off with the “Target” parameter set to 20 °C 
 stirring is off with the “Stir Speed” parameter set to 1200 rpm 
 ramping is off with the “Ramp Rate” parameter set to 0.50 °C 
 cuvette position is set to Position 1 

 
When you turn the TC 1 on, the MAIN display is shown (on right). 

This display shows the current sample holder temperature, the current target 
temperature and a probe temperature (if an external thermistor probe is being used). The page also shows 
whether the ramping function and the magnetic stirrer are turned on or off. 

 

Example: Temperature Control 

Figure 9.  Setting the target temperature and turning on temperature control.  

         
        initial display                            after adjustment                        after pressing SET 

 

Press the right arrow to go to the TARGET temperature display, which will look like the “initial display” in 
Figure 9. Then use the up arrow and down arrow buttons to adjust the “Target” parameter to 37 °C, and the 
display will be equivalent to the “after adjustment” example in the Figure 9. Press SET to begin temperature 
control (and return to the MAIN page). The green light on the TC 1 will begin flashing slowly and the 
temperature of the cuvette holder will begin increasing toward the new target temperature. The “after 
pressing SET” in Figure 9 shows what the display will look like after the SET button has been pressed, or 
you return to the TARGET temperature display from MAIN. 

 

Example: Stirring 

Figure 10.  Setting the stir speed and turning on stirring.  

         
initial display                              after adjustment                          after pressing SET 

 

Press the right arrow twice to go to the STIRRING display, which will look like the “initial display” in Figure 
10. Then use the up arrow and down arrow buttons to adjust the “Stir Speed” parameter to 700 rpm. The 
display will be equivalent to the “after adjustment” example in the figure.  Then press SET to turn stirring on 
(and return to the MAIN page with “Stir On” at the bottom). The “after pressing SET” in Figure 10 shows what 

Set Stirring      
 
Stir Speed = 1200rpm 
Current = Off 

Set Stirring      
                  
Stir Speed = 700rpm 
Current = Off 

Set Stirring      
                  
Stir Speed = 700rpm 
Current = 700rpm  

Set Target Temp.  
 
Target =  20.0°C   
Current=  20.0°C Off 

Set Target Temp.  
                    
Target =  37.0°C   
Current=  20.0°C Off 

Set Target Temp.  
                    
Target =  37.0°C   
Current=  37.0°C 

Holder = 22.9°C  POS 
Target = 20.0°C    1 
Probe  = 23.0°C 
Ramp Off Stir Off 
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the display will look like after the SET button has been pressed, or you return to the STIRRING display from 
MAIN. 

Section 8 of this user guide, Temperature and Stirring Speed Ranges for Cuvette Holders, summarizes the 
stirring speeds accessible for cuvette holders that use the QNW TC 1 Temperature Controller. 

 

Example: Setting up for ramping 

Figure 11.  Setting the ramp speed and turning on ramping.  

         
initial display                                after adjustment                              return display 

 

Press the left arrow twice (or press the right arrow three times) to go to the RAMPING display, which will 
look like the “initial display” in Figure 11. Then use the up arrow and down arrow buttons to adjust the 
“Ramp Rate” parameter to 1.00 °C/min (1.00 °/min in the display). The display will be equivalent to the “after 
adjustment” example in Figure 11. Then press SET to turn ramping on. After 5 seconds, the display will 
return to the MAIN page with “Ramp wTT” at the bottom.  The “wTT” indicates that the TC 1 is now waiting for 
a new target temperature to be set. The “after pressing SET” in Figure 11 shows what the display will look 
like after the SET button has been pressed, or you return to the RAMPING display from MAIN. 

If you have been performing the steps for this example, the cuvette holder will now be stable at 37 °C 
(indicated by the LED being on but not blinking) and the MAIN display will look like “waiting for TT to be set” 
in Figure 12. 

 

Figure 12.  The MAIN display while running a ramp.  

         
waiting for TT to be set                      during ramping                      after ramp is completed 

 

To start the ramping process, press the right arrow to open the TARGET temperature display and use the 
up arrow and down arrow buttons to adjust the “Target” parameter to 43 °C. Then press the SET button to 
change the target temperature (TT) and start the ramping process. The LED will begin blinking and the MAIN 
display will look like “during ramping” in Figure 12. The ramp will take 6 minutes to complete. When the 
“Target” is reached, the display will look like “after ramp is completed” in Figure 12. The “Holder” temperature 
may go a little above the “Target” of 43.0 °C before settling back. 

The fastest possible ramp is determined by how fast the cuvette holder could reach the target temperature 
without ramping. In other words, the maximum ramp rate will tend to be lower going down in temperature 
rather than up, and even lower if the target temperature is closer to a temperature extreme. The slowest ramp 
that may be set on this page is 0.01 °C/minute. 

Once you have completed the run, temperature control can be turned off by going to the TARGET 
temperature display and pressing the SET button. 

Set Ramping       
                  
Ramp Rate =0.50°/min  
Current = Off 

Set Ramping       
                  
Ramp Rate =1.00°/min  
Current = Off 

Set Ramping       
                  
Ramp Rate =1.00°/min  
Current = 1.00°/min 

Holder = 37.0°C  POS 
Target = 37.0°C    1 
 
Ramp wTT Stir On 

Holder = 40.3°C  POS 
Target = 43.0°C    1 
 
Ramp On  Stir On 

Holder = 43.0°C  POS 
Target = 43.0°C    1 
 
Ramp Off Stir On 
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Example: Setting cuvette position 

Figure 13.  Setting the cuvette position.  

         
 initial display                            after adjustment                         after pressing SET 

 

Press the left arrow once (or press the right arrow four times) to go to the POSITION display, which will 
look like the “initial display” in Figure 13. Then use the up arrow and down arrow buttons to adjust the 
“Target” parameter to 5, and the display will be equivalent to the “after pressing SET” example in Figure 13. 
Press SET to begin cuvette position adjustment (and return to the MAIN page). The “after pressing SET” in 
Figure 13 shows what the display will look like after the SET button has been pressed, or you return to the 
POSITION display from MAIN. For the qCHANGER 6, possible cuvette position values are 1, 2, 3, …, 6. 

Controlling the TC 1 Temperature Controller with Software 

For complex independent control of the sample and reference, we recommend the use of software. For 
example, the program T-App from Quantum Northwest permits the use of scripts that can greatly simplify 
temperature ramping and other processes that require multiple commands. 

Section 12, Elements of the T-App Software Help File, provides insights into the capabilities of temperature 
control using T-App. Examples of scripts are found in Section 13. 

4.3. Cooling Water for the Peltier 
The Peltier element (or “thermoelectric cooler”) is a heat pump.  When cooling, it transfers heat from the 
cuvette tower to the heat exchanger; when heating, electrical polarity is reversed and it transfers heat from 
the heat exchanger to the tower.  When cooling, it is particularly important to transfer this heat away from the 
Peltier unit.  This is accomplished with flowing water through the heat exchanger. 

A source of water (or other cooling fluid) must be connected to the -inch hose barbs on the side of the 
qCHANGER 6.  The QNW BATH 10 includes a submersible pump, the appropriate fittings for connecting 
tubing, and a plastic bucket.  Connect the pump to the qCHANGER 6, place it in the bucket with water, and 
run a return tube to the bucket.  A more robust pump is available as the BATH 100, although the larger pump 
has a higher wattage and tends to heat the water when used for extended periods of time.  An enclosed 
circulation system, the KOOL 440 is also available.  Details are available on www.qnw.com. 

Cooling water may also be provided from another source, such as a refrigerated cooling bath (or even a tap, 
for brief use only). 

The Peltier unit requires a flow of 100 to 300 mL/min.  This flow should require a pressure of about 3 - 5 psi 
(0.2 - 0.3 bar). 

 

CAUTION 

 

Caution - Do not exceed an input water pressure of 25 psi (1.7 bar), as damage may occur 
inside the qCHANGER 6. 

Set Position  
 
Target =  1   
Current=  1 

Set Position  
                    
Target =  5   
Current=  1 

Set Position  
                    
Target =  5   
Current=  5 
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Note:  The heat exchanger and hose barbs are brass, the tubing inside the qCHANGER 6 is 
silicone rubber and the external tubing is vinyl.  Be sure that any circulating fluid used, other 
than water, will not corrode these materials. 

The temperature of the heat exchanger in the qCHANGER 6 is monitored using a thermistor. If the 
temperature exceeds 60 °C, then temperature control is shut down to prevent damage to the Peltier element 
and the warning, “check coolant flow,” displayed on the TC 1 temperature controller.  This will happen if the 
circulating fluid gets too warm and/or is restricted in flow.  The heat exchanger temperature may be accessed 
by computer through the RS 232 or USB connections on the back of the TC 1 Temperature Controller. 

Temperature increases will be faster when room temperature water is used in the circulator.  Temperature 
decreases will be faster when ice water is used.  Only water should be circulated using the BATH 10.  When 
using a refrigerated bath, circulating pre-cooled fluids (such as 30% methanol or diluted ethylene glycol) at 
below 0 °C will permit measurements below the specified temperature range. 

4.4. Dry Gas to Minimize Condensation 
Dry gas flows into the qCHANGER 6 via the small -inch hose barb in the base of the unit.  It passes up 
through holes below the optical ports in the cuvette tower to fill the space next to the cuvette, preventing 
condensation on the surface of the cuvette.   

Note:  A flow of dry gas is necessary any time the qCHANGER 6 is controlled below the dew point 
temperature inside the sample compartment of the spectrometer. For ambient air, this would 
typically be about 5 °C. 

4.5. External Temperature Probe 
A -inch phone jack labeled “Probe” can be found on the back panel of TC 1 Temperature Controller.  This 
jack will accept the plug on a standard Series 400 or Series 500 thermistor probe. (For a Series 400 probe, 
consider the YSI 423 semi-flexible thermistor probe.) When a probe is plugged into the jack, the probe 
temperature is presented on the display of the TC 1. Place the probe in the sample to measure the actual 
temperature of the sample, which will lag in time from the temperature of the cuvette tower. 

Excellent Series 500 probes may be obtained with diameters less than 1 mm, providing access to small 
sample volumes. A disadvantage of these probes is that they are not pre-calibrated. Note that a probe may 
be easily calibrated using the calibration hole found in the upper surface of any Quantum Northwest cuvette 
holder (Section 4.6). 

4.6. Calibration/Support Hole 
Each cuvette holder made by Quantum Northwest has a calibration/support hole drilled in the upper 
surface next to a cuvette position. In the qCHANGER 6, this hole is between the second and third cuvette 
positions. The calibration/support hole is used for the NIST-traceable calibration of the device before it is 
shipped. 
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The top of the calibration/support hole is tapped with an M4 metric thread, which is plugged with a 
stainless-steel set screw. For access to the hole, remove the screw. To calibrate a Series 400 or Series 500 
temperature probe, insert the probe and set temperatures over the range of interest, recording holder and 
probe temperatures as reported by the TC 1 Temperature Controller. To use the calibration/support hole to 
affix any device to the top of the cuvette holder, attach it using an M4 screw. Thus, for example, one might 
attach a post or other device to be used to support tubing or electrical wires that must access the cuvettes. 

4.7. External Computer Control 
All functions may be accessed either through a Serial (RS 232) or a USB located on the back of TC 1 
Temperature Controller. These functions are described in Section 10, Terms Used in Serial Communications 
with the TC 1, and Section 11, Serial Communications for the TC 1 Temperature Controller. You may write 
your own program or purchase the QNW application T-App. T-App will plot temperatures of the probe, 
cuvette tower, and even the Peltier element heat exchanger vs time. It will also permit you to set up 
temperature ramps. These functions are described in Section 12, Elements of the T-App Software Help File, 
and Section 13, Example Controller Scripts for T-App Software. 

4.8. Working at Extended Temperatures 

Section 8, Temperature and Stirring Speed Ranges for Cuvette Holders, summarizes the temperature 
ranges accessible for cuvette holders that use the QNW TC 1 Temperature Controller.  If working at high or 
low temperatures, consult Section 9, Working at High and Low Sample Temperatures at the Laboratory 
Bench, for detailed advice on how to achieve cuvette temperatures far removed from room temperature. 
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5. Troubleshooting and Maintenance 

5.1. Troubleshooting 

If the submersible pump has operated without being immersed in water, it may not prime properly.  If this 
occurs, place one drop of detergent on the pump intake and try again. 

If the TC 1 display indicates that there is inadequate coolant (see Section 5.2, error message 8), it may be 
that the circulating water is too warm. Add ice to the water to cool it down. 

If a microcuvette is used requiring a z-height of other than 15 mm, spectroscopic measurements may be 
erratic and erroneous as the spectrometer's light beam may be partially blocked by the masking on the 
cuvette. Set the spectrometer to a visible wavelength (e.g., 550 nm), darken the room, and use a white card 
to help trace the pathway of the light beam into the cuvette. If the cuvette interferes with the light beam, use a 
different cuvette. For a discussion of cuvette z-height, see Section 2.1. 

If a cuvette is difficult to remove, it may be shorter than the minimum 30-mm height required for cuvettes in 
the qCHANGER 6. Use a taller cuvette instead. 

For an explanation of notations on the display screen of the TC 1 Temperature Controller, see Section 6, 
Glossary of Terms Appearing on the TC 1 Front Panel Display Screen. 

For an explanation of the LED lights on the display screen of the TC 1 Temperature Controller, see Section 
7, LED Status Indicators on the TC 1 Front Panel. 

5.2. Error Messages 
When errors occur, the line 1 of the TC 1 Temperature Controller display presents an error code.  Line 3 of 
the display identifies the error and line 4 of the display presents possible solutions. The most common events 
that cause errors to be displayed are loose cables or inadequate coolant flow.  For errors not easily solved, 
contact QNW at www.qnw.com/contact-us/ or service@qnw.com. 

Specific error messages include the following. 

 

5 – cell out of range 

warnings: loose cable, sensor failure 

The temperature controller is not receiving a reasonable response from the sensor on the cuvette tower.  
Either the sensor has failed or a cable is not making a good connection. 

 

6 – cell out of range 

warnings: loose cable, check cable 

The temperature controller is not receiving reasonable responses from either the cell tower or heat exchanger 
sensors.  Since it is very unlikely for both to fail, probably a cable is loose. 
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7 – heat exchanger error 

warnings: loose cable, sensor failure 

The temperature controller is not receiving a reasonable response from the sensor on the heat exchanger.  
Either the sensor has failed or a cable is not making a good connection. 

 

8 – inadequate coolant 

warnings: inadequate coolant, water temperature 

The sensor on the heat exchanger is reading a temperature above 60 °C.  Temperature control has been 
shut down to prevent damage to the Peltier element.  Either the water was too warm or the rate of flow was 
inadequate to draw sufficient heat from the heat exchanger. 

5.3. Maintenance 
The qCHANGER 6 and TC 1 Temperature Controller require very little routine maintenance on the part of the 
user.  For routine cleaning of exposed surfaces, use only a cloth dampened with water or diluted detergent.  
Do not use organic or abrasive solvents. 

CAUTION 

 

Caution – Any action which makes it necessary to open the qCHANGER 6 or TC 1 Temperature 
Controller units must be executed only by QNW technicians or authorized personnel. 

 

The water hoses and their attachments to the qCHANGER 6, TC 1 Temperature Controller, and submersible 
pump should be inspected prior to each usage to ensure that they are intact. Replace the vinyl tubing when it 
becomes discolored or cracked. Periodically replace the water stored in the bucket to minimize the growth of 
microorganisms.  When not in use, the pump, bucket, and tubing may be stored dry. 

5.4. Spare Parts 
Vinyl tubing and magnetic stir bars may be obtained from a variety of commercial vendors.  For electrical 
cables to be used with qCHANGER 6 and TC 1 Temperature Controller and submersible pumps, please 
contact QNW at service@qnw.com. 
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6. Glossary of Terms Appearing on the TC 1 
Front Panel Display Screen 

Term Meaning 

Holder 
The temperature measured inside the Peltier-controlled cuvette holder, expressed in degrees 
Celsius (°C) 

ID=n 
The type of device being controlled by the TC 1 controller; ID=14 for SINGLE cuvette holder; 
ID=24 for DUAL; ID=34 for MULTI; ID=00 for specialty device 

LKK 
The control of the Reference and Sample cuvettes is linked so that control parameters of the 
Reference cuvette are identical to those of the Sample cuvette, and the TC 1 controller is under 
the command of an external computer control program (DUAL only) 

LNK 
The control of the Reference and Sample cuvettes is linked so that control parameters of the 
Reference cuvette are identical to those of the Sample cuvette, and change is possible only 
through the Sample cuvette settings (DUAL only) 

LOK 
The TC 1 controller is under the command of an external computer control program, and that 
program has locked the front panel to prevent the manual changing of settings 

Off 
For Ramping or Stirring, the function is not running either by default, or because the SET button 
was pressed while the function was running 

On 
For Ramping or Stirring, a valid parameter has been entered, and the SET button has been 
pressed 

POS 
The Position number (1, 2, 3, …) of the cuvette currently in the light beam of the spectrometer 
(MULTI only) 

Probe 
The temperature measured by an external probe, positioned by the user, expressed in degrees 
Celsius (°C) 

Ramp 
A setting of a rate of linear temperature change of the Peltier-controlled cuvette holder, expressed 
in degrees Celsius per minute, leading to the desired target temperature (°C /min) 

REF The Reference cuvette of a Reference/Sample cuvette pair (DUAL only) 

RElink 
The command to link the control of the Reference and Sample cuvettes such that the Reference 
cuvette receives control identical to that of the Sample cuvette (DUAL only) 
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SAM The Sample cuvette of a Reference/Sample cuvette pair (DUAL only) 

Stir A setting of stirring of a magnetic stirrer under a cuvette, expressed in revolutions per minute (rpm) 

Target 
The value of the temperature being targeted for the Peltier-controlled cuvette holder, expressed in 
degrees Celsius (°C) 

TT 
The target temperature set for the Peltier-controlled cuvette holder, expressed in degrees Celsius 
(°C) 

UNlink 
The command to unlink the control of the Reference and Sample cuvettes such that the Reference 
and Sample cuvettes may be controlled independently of each other (DUAL only) 

Version The version number of the firmware used in the TC 1 controller 

wTT 
The Ramp condition of waiting for a new target temperature to be set, following the setting and 
activation of a ramp rate 
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7. LED Status Indicators on the TC 1 Front 
Panel 

Light Status Indication 

Off No active temperature control 

Flashing Green Seeking target temperature 

Solid Green Maintaining target temperature 

Flashing Red An error has occurred - see error messages in Section 5.2
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8. Temperature and Stirring Speed Ranges for 
Cuvette Holders 

Cuvette 
Holder 
Class 

Cuvette Holder 
Type 

Stirring 
Motor 
Type 

Effective 
Minimum/ 
Maximum 

Stirring Speed, 
rpm 

Factory Set 
Minimum/ 
Maximum 

Temperature, °C 

Reasonable 
Laboratory 
Minimum/ 
Maximum 

Temperature, °C 

Single t2 Sport 
Direct 

Current 
200 to 1800 -40 to +110 -15 to +110 

Single Versa 20 
Direct 

Current 
900 to 1800 -40 to +105 -15 to +105 

Single 
Versa 20/E 
Extended 

Temperature 

Direct 
Current 

900 to 1800 -55 to +150 -50 to +150 

Single CD 250 
Direct 

Current 
900 to 1800 -40 to +105 -15 to +105 

Single 
CD 250/E 
Extended 

Temperature 

Direct 
Current 

900 to 1800 -55 to +150 
depends on 

cuvette 

Single Luma 40 
Direct 

Current 
900 to 1800 -40 to +105 -15 to +105 

Single 
Luma 40/E 
Extended 

Temperature 

Direct 
Current 

900 to 1800 -55 to +150 -50 to +150 

Dual t2x2 Sport 
Direct 

Current 
200 to 1800 -40 to +110 -15 to +110 

Multi Turret 4 Stepper 60 to 1800 -40 to +110 -15 to +110 

Multi Turret 6 Stepper 60 to 1800 -40 to +110 -25 to +110 

Multi qCHANGER 6 Stepper 60 to 1800 -40 to +110 -15 to +110 

 

CAUTION 

 

Caution - See Section 9 for a complete discussion of what minimum and maximum 
temperatures are achievable with Quantum Northwest products under standard laboratory 
conditions. Attempting to reach the factory set limits may damage the instrument if care is not 
taken. 
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9. Working at High and Low Sample 
Temperatures at the Laboratory Bench 

9.1. Thermostatting a Liquid Sample in a Cuvette at 
Temperatures Other Than Room Temperature 

A standard spectrophotometer for UV-Vis-NIR absorbance or fluorescence comes with a cuvette holder for 
the liquid sample and often a second one for the reference sample.  The cuvette holders are housed in the 
sample compartment of the spectrometer on a lab bench.  “Room temperature” is often cited when specifying 
the temperature at which a sample was held when a spectrum was measured.  For many situations, this is 
adequate.  For sensitive measurements – either because the sample is chemically different at different 
temperatures, or its spectra are different at different temperatures – it is necessary to control the temperature 
of the sample to a precisely set value. 

One way of altering the sample temperature of a cuvette holder uses a temperature-controlled circulating 
water bath (containing water or a mixture of water and another solvent), and a cuvette or cuvette holder that 
allows the flowing water to directly cool or heat the cuvette.  Using such a system, the sample temperature 
often does not match the temperature of the circulating fluid. Alternatively, a Peltier cuvette holder can be 
used.  A Peltier unit uses thermoelectric cooling/heating to alter the sample temperature.  Such control 
typically occurs much more rapidly and precisely over a wider range of temperatures. With a Peltier cuvette 
holder, the circulating water bath is used to remove heat from the Peltier’s heat exchanger rather than directly 
influencing the temperature of the sample in the cuvette.  Air-cooled Peltier units use air rather than liquid for 
removing heat from the heat exchanger, and have more limited temperature ranges available to them. 

Problems arise at both hot and cold temperatures.  As a sample in a cuvette gets warmer, bubbles are likely 
to form in the cuvette.  Left in place, they scatter incident light and create artifacts in spectra.  Cold samples 
are problematic at or below the dew point of the ambient air, as condensation forms on the surface of the 
cuvette.  This condensation also scatters incident light, creating artifacts in spectra.  As the temperature is 
lowered, the condensed water may freeze, causing issues with icing on the cuvette holder and potential 
damage to the cuvette holder or the spectrometer when the ice melts. 

9.2. Successfully Working at High and Low Temperatures 
Work at any temperature benefits from having the sample in the cuvette stirred using a magnetic stirrer built 
into the cuvette holder and a stir bar placed in the cuvette.  This eliminates temperature gradients in the 
sample and facilitates more rapid equilibration to the set temperature.  For high sample temperatures, up to 
+150 °C, magnetic stirring also helps dislodge bubbles that may form inside the cuvette as dissolved gases 
become less soluble with increasing temperature, although degassing samples before measurements is a 
more reliable means of preventing the artifacts that they cause.  

Low temperature work must address the condensation of water on cuvette surfaces that are exposed to the 
atmosphere.  The condensation can be limited by the application of a flow of dry gas (dried air, nitrogen, or 
argon, for example) to the surface of the cuvette while the sample is chilled.  For cuvette holders used inside 
the sample chamber of a spectrometer, the whole sample compartment can be purged with dry gas. 

How low can you go?  For low-temperature spectroscopy with a benchtop spectrometer, many factors come 
into play.  With Peltier cuvette holders, achieving low temperatures can be aided by the circulation of 
precooled liquid through the Peltier heat exchanger. For example, when using ice water at 0.0 °C, Peltier 
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cuvette holders will easily approach -25 °C or so. To go lower, circulation of precooled fluids below 0.0 °C is 
required. The use of 30% methanol-water as the circulating liquid is recommended, since it has ample heat 
capacity and low viscosity, permitting adequate flow through the heat exchanger. It should be possible to 
achieve a sample holder temperature about 25 °C lower than that of the circulating fluid.  

The final consideration for achieving high and low extended temperatures with a benchtop spectrometer is 
the amount of insulation that can be positioned around the cuvette holder without obstructing the light beam 
in and out of the cuvette, and while maintaining normal operation of the spectrometer itself.  Typically, 
spectrometer manufacturers do not provide either the insulation or the guidance on how to craft a well-
insulated sample chamber for their products.  This is left to the operator, and is often the final factor on 
whether or not an extended temperature can be reached.  Creativity is required in using foam packing 
material or other foam products, often with tape and rubber bands, to provide the insulation required for the 
temperature desired. 

9.3. Strategies for Working with Quantum Northwest 
Products at Extreme Temperatures 

Quantum Northwest’s Peltier cuvette holders provide not only temperature control, but also stirring and dry 
gas purging. 

Extended temperature spectroscopy ranges are available for UV-Vis-NIR absorbance, fluorescence, fiber 
optic, flash photolysis, photoacoustic and circular dichroism applications: 

 Versa 20/E family of products for UV-Vis-NIR spectrophotometry 
 Luma 40/E and TLC 50 Legacy/E families of products for fluorescence spectroscopy 
 qpod/E cuvette holder for fiber optic spectrometers 
 Flash 300/E stand-alone device for laser flash photolysis and pulsed-laser photoacoustics 
 CD 250/E cuvette holder for circular dichroism spectrometers 

 

These cuvette holders can be specially built to extend their temperature ranges from their normal range of -
40 to +105 °C. Choosing the extended temperature option – denoted by /E – extends this control range to -55 
°C to +150 °C. This requires the use of materials that are stable at the high and low temperatures, sensors 
with extended range, and design details that protect the delicate magnetic stirring motors. The Versa 20, 
Luma 40 and Flash 300 can be provided with windowed jackets to trap dry gas around the cuvette holder to 
eliminate condensation and frosting. 

The lowest measured temperature reached to date at Quantum Northwest’s manufacturing facility in Liberty 
Lake, WA, USA, was -52.7 °C with an extended temperature Flash 300/E, considerable added insulation, and 
circulating fluid of -20 °C.  This is short of the -55 °C claimed for the extended temperature (/E) products.  
Why is this?   

In short, with an extended temperature product, the user can send a control command to the unit to go to -55 
°C; but, whether the unit will actually go to -55 °C depends on whether cold circulating fluid is used, and how 
well insulated the sample holder is.  This situation is analogous to trying to chill a room to 15 °C with a 
powerful air condition unit, but if the user keeps the windows open on a hot summer day, the room will not 
likely get to 15 °C.  The scientist’s ability to customize and maximize the foam insulation around the cuvette 
holder is usually the key determinant to achieving low temperature spectroscopy without specialty cryogenic 
devices. 
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9.4. Summary 
Sample temperatures approaching -55 °C and up to +150 °C are possible in a standard benchtop 
spectrometer.  Magnetic stirring is required for extended temperature work.  The temperature of the 
circulating water bath needs to be controlled, and it may be necessary to blend the water with another solvent 
such as methanol to reach the required temperatures.  For cold temperature work, dry gas must flow onto the 
surface of the cuvette to reduce condensation and ice build-up, and additional insulation must be added to 
surround the cuvette holder without obstructing the light beam. 

For Quantum Northwest Peltier products that operate at extended temperatures, the following temperatures 
are achievable under the approximate conditions: 

5 °C – lowest temperature in the open air (with typical humidity), no dry gas flow; 

-10 °C – lowest temperature in an exposed environment but with dry gas flow; 

-25 °C – lowest temperature in an enclosed, dry environment, with 0 °C circulating fluid; 

-40 °C – lowest temperature with a windowed jacket surrounding the cuvette holder, -15 °C circulating fluid, 
some added insulation; 

-55 °C – lowest possible temperature with a windowed jacket surrounding the cuvette holder, -30 °C 
circulating fluid, and maximum added insulation. 
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10. Terms Used in Serial Communications 
with the TC 1  

 

Section 11 describes in detail the commands used for serial control of the TC 1 Temperature Controller.  The 
table below summarizes the main commands and their definitions. 

Command  Definition 

+  On 

‐  Off 

CT  Current temperature of the cuvette holder, degrees Celsius (°C) 

ER  Error 

FP  Front panel input 

HL  High temperature limit of the heat exchanger of the cuvette holder, degrees Celsius (°C) 

HT  Current temperature of the heat exchanger of the cuvette holder, degrees Celsius (°C) 

ID  Identification of cuvette holder type (Single, Dual, Multi, or specialty device) 

IS  Instrument status 

LK  Link the reference cuvette settings to those of the sample cuvette 

LO  Lock out the front panel from user input through the control buttons 

LS  Lowest stirrer speed, revolutions per minute (rpm) 

LT  Lowest target temperature allowed, degrees Celsius (°C) 

MS  Maximum stirrer speed, revolutions per minute (rpm) 

MT  Maximum target temperature allowed, degrees Celsius (°C) 

PA  Automatic reporting of probe temperature 

PR  External probe connected 

PS  External probe status 

PT  Probe temperature, degrees Celsius (°C) 

PX  Probe temperature precision 

R  Automatic reporting (of SS, for example) 

RR  Ramp rate, degrees Celsius per minute (°C/min) 

SS  Stirrer speed, revolutions per minute (rpm) 

TC  Temperature control 

TT  Target temperature, degrees Celsius (°C) 

VN  Version number of the TC 1 controller firmware 

W  Ramp mode is waiting for target temperature input 
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11. Serial Communications for the TC 1 
Temperature Controller 

7/19/2016 

Note:  This document provides the serial communications protocols for version 2.22 of the 
firmware on the TC 1 family of controllers. 

TC 1/Single – for single cuvette holders such as the t2 Sport, Versa 20, Luma 40, CD 250 and Flash 300; 

TC 1/Dual – for dual independent control for sample and reference cuvettes of the t2x2 Sport and Versa 
20x2; 

TC 1/Multi – for multi-position sample changers such as the qCHANGER 6 and the Turret 6. 

The version number and the ID (see below) are shown briefly on the display when the temperature controller 
is turned on.  This initial display can be repeated by pressing the down arrow on the front panel of the 
controller. 

All functions of the temperature controller can be managed from a computer, using the command set 
described below.  If you purchased your unit as a component of a spectrometer from certain manufacturers, 
this feature may be implemented through traditional RS232 serial connectors on the computer, or the 
spectrometer and on the controller.  In this case, they will be connected by a standard 15-pin serial extension 
cable (male connector on one end and female on the other).  No driver installation should be needed. 
Otherwise the serial linkage will be established through a USB connection between the computer and the 
controller.  In this case the controller includes electronics which convert the USB connection to a serial 
communications port.  However, for the port to be available to programs on the computer, it will be necessary 
to load driver software.   
 
CAUTION 

 

Caution - It is important that the driver software be loaded before connecting a USB cable 
between the controller and the computer.  Contact Quantum Northwest for further information. 

 
Quantum Northwest offers the T-App control program written specifically for control of all functions of the 
temperature controller and to track temperature as a function of time.  The resulting data can be saved to a 
text file (two columns, time and temperature, tab delimited) or copied and pasted directly into another 
program (such as Microsoft Excel).  If you expect to create software or firmware that communicates with a TC 
1 controller, T-App may prove extremely useful for preliminary testing of controller commands. 
 
In programming for the TC 1 controller, one must adhere to the conventional notation: 8/N/1. 
 Baud:  19200 
 Data Bits:  8 
 Parity:  None 
 Stop Bit:  1 
 Flow Control: None 

For many of the commands listed below, the controller returns information in response to the command.  All 
commands and responses are delineated by left and right square brackets ( [  ] ).  Any text sent to the 
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controller not enclosed within brackets will be ignored.  In this document, an ellipsis (…) is used to distinguish 
responses from commands. 

Note:  The format of the commands is shown below. 

 

[command] Purpose of the command (sent to the controller). 

...[response] Meaning of the response (received from the controller). 

 
 

11.1. Sample Holder ID Number 
[F1 ID ?] What is the ID number of the sample holder being controlled?  

...[F1 ID 14] ID is 14. 

 
      

Assigned Identities:  

ID = 00 specialty sample holder 

 14 single 

 24 dual 

 34 turret or linear multi-sample holder 

11.2. Controller Firmware Version 
[F1 VN ?] What is the Version Number of the controller firmware? 

...[F1 VN 2.22] The controller firmware version number is 2.22. 

11.3. Stirrer 
[F1 MS ?] What is the Maximum stirrer Speed? 
...[F1 MS 2500] The maximum stirrer speed permitted is 2500 rpm. 
[F1 LS ?] What is the Lowest stirrer Speed? 
...[F1 MS 300] The lowest stirrer speed permitted is 300 rpm. 
[F1 SS S 1000] Set Stirrer Speed to 1000 rpm and turn stirring on. 

[F1 SS S 0] Turn stirrer off (does not change the speed setting). 

[F1 SS +] Turn stirrer on and set it to the most recent non-zero stirrer speed setting. 

[F1 SS -] Turn stirrer off (this does not change the speed setting).. 

[F1 SS ?] What is the current stirrer speed setting?  Depending on the R+/R- state as 
specified below, the stirrer status (’+’/on or ’-’/off) may also be reported. 

...[F1 SS 1000] Stirrer speed setting is 1000 rpm. 

...[F1 SS -] Stirrer status is off. 
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[F1 SS R-] Turn off automatic Reporting of the stirrer speed and status when changed by a 
command. 

[F1 SS R+] Turn on automatic reporting of stirrer changes. 

The power on default setting is to not report the speed or the status when 
changed. 

If you then send [F1 SS R+], only the stirring speed will be reported when 
changed. 

If you then send [F1 SS R+], both the speed and the status will be reported when 
changed. 

If you then send [F1 SS R-], neither the speed nor the status will be reported when 
changed (back to the power on default setting). 

Note that the [F1 SS ?] will always result in a stirring speed response.  The status 
response will also be sent if it has been enabled as described above. 

11.4. Temperature Control 
[F1 TC +] Turn Temperature Control on. 

[F1 TC -] Turn temperature control off. 

[F1 TC ?] What is the current status of temperature control? 

...[F1 TC -] Temperature control status is ‘-‘/off. 

[F1 TC R+] Report temperature control status when changed by a command. 

[F1 TC R-] Do not report temperature control status when changed. 

11.5. Target Temperature 
[F1 MT ?] What is the Maximum Target temperature setting allowed for this holder? 

...[F1 MT 105] The maximum target temperature allowed is 105 ºC. 

[F1 LT ?] What is the Lowest Target temperature setting allowed for this holder? 

...[F1 LT -30] The lowest target temperature allowed is -30 ºC  

[F1 TT S 23.10] Set the Target Temperature to 23.10 ºC. 

 Note:  The TC 1 does not turn temperature control on when TT is received (as it 
does when the front panel controls are used to set the TT).  

[F1 TT ?] What is the current target temperature? 

...[F1 TT 71.32] Target temperature is 71.32 ºC. 

[F1 TT +] 

  or [F1 TT R+] Turn on automatic reporting of the target temperature when changed by a 
command. 

[F1 TT -] 

  or [F1 TT R-] Turn off automatic reporting of target temperature changes. 
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11.6. Instrument Status 
[F1 IS ?] What is the current Instrument Status?    

...[F1 IS 0-+S] Response is four parameters (or five, see below):    
   number of unreported errors is 0 (0 or 1);   
   stirrer is off (+ is on, - is off); 
   temperature control is on (+ is on, - is off);   
   current sample holder temperature is stable (S is stable, C is changing). 
  

[F1 IS +] Automatically report instrument status whenever it changes  
  or [F1 IS R+]   (e.g., when the sample holder temperature goes from changing to stable). 

[F1 IS -] 

  or [F1 IS R-]  Stop automatic reports of instrument status when it changes (the power-on 
default). 

  

[F1 IS E+] Include the ramp status as a fifth parameter in the instrument status response.   

...[F1 IS 0-+SW] The ramp status will be one of three states represented by the characters 
 ‘-‘ ('minus', ramping off),  ‘+‘ ('plus', ramping on) or ‘W‘(waiting for TT).  See 
subsection 11.10 for details. 

[F1 IS E-] Stop including the ramp status in the instrument status response (power-on 
default). 

11.7. Current Sample Holder Temperature 
[F1 CT ?] What is the Current Temperature of the sample holder?   

...[F1 CT 22.84] The current temperature is 22.84 ºC.    

[F1 CT +3] Periodically report current temperature every 3 seconds.  

[F1 CT -] Stop periodic current temperature reports. 

[F1 CT +] Restart periodic probe temperature reports using the current interval (the power-on 
default is a 3-second interval). 

 

[F1 CT R+] Report status of the sample holder temperature when it changes. 

...[F1 CT C] The status of CT is changing. 

...[F1 CT S] The status of CT is stable (CT has stayed within +/-0.05 °C of the target 
temperature for at least 1 minute. 

[F1 CT R-] Stop reporting changes in the status of CT (power-on default). 

11.8. Error Reporting 
[F1 ER ?] Report the current error (ERror). 

...[F1 ER -1] No current error. 

...[F1 ER 05] Cell T out of range (Loose cable? Sensor failure?). 

...[F1 ER 06] Both cell and heat exchanger T out of  range (Loose cable?). 

...[F1 ER 07] Heat exchanger T out of range (Loose cable? Sensor failure?). 
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...[F1 ER 08] Inadequate coolant (check  flow).  Temperature control has shut down.  

...[F1 ER 09<<bad command>>]  

 Syntax error on a preceding command where “bad command” is the text 
of the command that caused the syntax error response.  

[F1 ER +] Automatically report errors when they occur. 

[F1 ER -] Stop automatic error reports (this setting has no effect on ER 9 responses). 

11.9. Probe Status and Temperature 
[F1 PS ?] What is the Status of the TC 1 external Probe connector? 

...[F1 PR +] A series 400 thermistor probe is connected. 

...[F1 PR -] No probe is connected. 

[F1 PS +] Enable probe status to be Reported automatically when a probe is 
  or [F1 PS R+]   installed or removed. 

[F1 PS -] 

  or [F1 PS R-] Disable automatic sending of probe status (power-on default). 

 

[F1 PT ?] What is the current Probe Temperature? 

[F1 PT +3] Periodically report the probe temperature every 3 seconds (integers only, the ‘+’ is 
required). 

...[F1 PT 22.37] The current probe temperature is 22.37 °C. 

...[F1 PT NA] Probe temperature is not available.  

[F1 PT -] Stop periodic probe temperature reports.  The interval is retained. 

[F1 PT +] Restart periodic probe temperature reports using the current interval (the power-on 
default is 3 seconds). 

 

[F1 PA S 0.5] Set the temperature interval for Automatic reporting of the Probe temperature 
   to 0.5  °C during a ramp. (Increment must be positive,  
   without sign in tenths between 0.1 and 9.9 °C, and will 
   work for ramps going up or down.) 

 Note:  this command does not start automatic reporting, it just sets the interval to 
be used when it is turned on. 

[F1 PA ?] What is the current temperature interval for automatic reporting? 

...[F1 PA 0.5] The interval is 0.5 °C. 

[F1 PA +] Start automatic reporting of probe temperature at temperature 
   intervals (set by the command above). 

[F1 PA -] Stop automatic reporting of probe temperature every temperature 
   increment. 

 
[F1 PX +] Change probe temperature returned to a precision of 0.01 °C. 
[F1 PX -] Change probe temperature returned to a precision of 0.1 °C. 
 
Note:  Since probe temperatures are always reported to 0.01 °C by the TC 1 controller, these last two 

commands have no effect.  They are included to maintain compatibility with customer software / 
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firmware based on the older TC 125, TC 225 and TC 425 temperature controllers (i.e., they will not 
cause an [F1 ER 9 <<….>>] report – see subsection 11.8). 

 
Note:  Except for [F1 PS ?] and [F1 PS R(+/-)], any probe related command issued when a probe is not 

connected to the TC 1 will result in the warning response [F1 NOPROBE]. 

11.10. Temperature Ramping 
 [F1 RR S 0.50] Sets the ramp rate to 0.50 °C/minute.  This command also sets the ramp status to 
’W’/ waiting mode (see below).  With the exception of 0 the ramp rate must be in the range 0.01 to 10; 
otherwise an ER 9 reply will be returned by the controller, the ramp rate will be set to the nearest allowed 
value, and the controller will send a second response specifying the ramp rate that was set. 

 
[F1 RR S 0]   

   or [F1 RR -] Sets ramp status to ’-’/off (but does not change the current ramp rate setting).    
If either command is sent during a temperature ramp, the controller will then 
drive at maximum to the last set target temperature. 

[F1 RR +] Set ramp status to ’W’/ waiting mode. 
In waiting mode the TC 1 is waiting for a new target temperature to be set (see 
subsection 11.5).  When the TT command is received, if temperature control is 
on (see subsection 11.4) the controller begins ramping the temperature from 
the current value to the new TT at the previously specified ramp rate.  If 
temperature control was off when the TT command is received, the ramping 
process does not begin until it is turned on.  In either case the ramping state is 
’+’/on until the ramp is completed or cancelled.  

 If this command is sent while a ramp is in progress, the ramp status will change to 
’W’/ waiting and the controller will drive at maximum to the last target 
temperature set. 

[F1 RR ?] What is the current ramp rate setting?  Depending on the R+/R- state as specified 
below, the ramp status ( ’W’/waiting, ’+’/on or ’-’/off) may also be reported. 

...[F1 RR 1.00] Current ramp rate is 1.00 °C/minute. 

...[F1 RR W] Ramp status is waiting. 

[F1 RR R-] Turn off automatic reporting of the rate and ramp status when changed by 
command or by use of the front panel. 

[F1 RR R+] Turn on automatic reporting of ramp changes.  Automatic reports will be sent by 
the controller when the ramp rate or status is changed by command. 

The power on default setting is to not report the ramp rate or the ramp state when changed. 
If you then send [F1 RR R+], only the ramp rate will be reported when changed. 
If you then send [F1 RR R+], both the rate and the state will be reported when changed. 
If you then send [F1 RR R-], neither the rate nor the state will be reported when changed (back 

to the power on default setting). 
Note that the [F1 RR ?] will always result in a ramp rate response.  The ramp status response will 

also be sent if it has been enabled as described above. 

 

The following seven commands, are accepted by and work with the TC 1.  They are provided mainly to 
maintain compatibility with control software/firmware developed for use with the older TC 125/225/425 
family of temperature controllers.  
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There are no corresponding reference commands (see subsection 11.13) for the TL commands. 

[F1 TL +] Ramp the sample and reference identically. 

[F1 TL -] or. 

      [F1 TL 0] Ramp the sample and reference independently (the power on default). 

 

[F1 RS S #],  [F1 RS ?] Set or query the RS parameter (# is a positive integer). 

[F1 RS S #],  [F1 RS ?]  Set or query the RT parameter (# is a positive integer). 

RS and RT provide an alternate method of setting the ramp rate.   

If the last set command for RS or RT results in both set to positive values (even if the actual 
setting is not changed by the command), they are used to calculate RR for actual use by the 
firmware and the ramp status is set to ‘W’/waiting. 

If ramp status is ‘W’/waiting or ‘+’/ramping, setting both RS and RT to 0 will change the status to 
‘-‘/off (but will not change the ramp rate setting). 

To Ramp the temperature:  
1.  equilibrate at the starting temperature; 
2.  set the ramp rate;  
3.  set a new target temperature (subsection 11.5). 

The target temperature may be above or below the current temperature; as soon as it is set, the ramp will 
begin, up or down, to that new target. 

After reaching the target, the controller will hold at that temperature.  At any time, a new ramp rate and target 
temperature can be set to start a new ramp. 

Once the ramp is completed, if you want to start another ramp (even using the same ramp rate) you must 
send the ramp rate set command.  Otherwise, setting a new target temperature will cause the controller to 
drive at maximum to the new target. 
 

Note:  The following details aid in running T-App.  

3. The minimum settable ramp rate (using the [F1 RR S #] command) is 0.01 °C/minute.  The maximum 
is 10 °C/min. 

4. For higher ramp settings, the observed rate may be lower than that specified or it may be nonlinear 
over part of the temperature range because the maximum possible rate of heating or cooling is 
limited (and dependent on the ramp direction as well as on the temperature). 

5. For compatibility with the TC 125/225/425 family of controllers, when the ramping process is 
completed the controller will send an [F1 TT #] response, where # will be the target temperature used 
to start the ramp.  Depending on automatic reply settings, an [F1 RR -] and/or [F1 IS 0++C-] 
response may also be sent by the TC 1. 

6. When the ramp status is ‘+’/On, sending a [F1 TT S #] command or a [F1 TC -] command will change 
the ramp status to ‘-‘/Off. 

11.11. Heat Exchanger Temperature 
[F1 HT ?] What is the current temperature of the heat exchanger? 

[F1 HT +3] Start periodic heat exchanger temperature reports every 3 seconds. 

...[F1 HT 39.23] The current heat exchanger temperature is 39.23 ºC. 
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[F1 HT -] Stop periodic heat exchanger temperature reports. 

[F1 HL ?] What is the high temperature limit for the heat exchanger? 

...[F1 HL 60] The heat exchanger high temperature limit is 60 ºC. 

In operation with temperature control on, if the HT parameter exceeds HL, the TC 
1 will turn temperature control off.  It will also send [F1 ER 8], [F1 TC -] and/or 
[F1 IS …] (with parameter 3 = ‘-‘/minus) depending on the current auto-reply 
settings (see below). 

11.12. Cell Changing 

Note:  These commands are valid only for a sample holder with multiple cuvette positions. 

[F2 DI] Device initialize: move to home position, then back to the current position setting. 

[F2 PI] Device initialize: move to home position, then back to the current position setting 
   and reply when done. 

...[F2 DL 1] Device is finished moving.  (Original reply was OK rather than DL 1) 

[F2 DL 3] Device locate: move to position 3.  (Device should be 
   initialized prior to using this command for the first time.)  

[F2 DL ?] or 

[F2 PL ?]  What is the current position? 

...[F2 DL 1] Device is in position 1. 

[F2 PL 4] Device locate: move to position 4 and reply when done.  (Device should be 
   initialized prior to using this command for the first time.) 

...[F2 DL 4] Device is now in position 4. 

[F2 ?] What is the current motor status? 

...[F2 OK] Most recent move is complete. 

...[F2 BUSY] Most recent move is still in progress. 

11.13. Reference Cuvette 

Note:  These commands are valid only for systems with two independently-controlled sample 
holders.  Otherwise, they will cause an ER 9 response. 

[R1 ...] 
 

To control and monitor the temperature and status of the reference cuvette using a Dual Temperature 
Controller, use any commands in subsections 11.1-11.8, 11.10 and 11.11, substituting R1 for F1.  There are 
no corresponding [R1 …] commands for subsections 11.9 and 11.12. 
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11.14. Front Panel Controls 

Note:  The TC 1 can be controlled manually using the buttons and the display on the front.  Once a 
control program has connected to the TC 1, the controller will automatically send reports to the 
program whenever a manual change has been made.  The commands in this section allow the 
program to control access to front panel (FP) settings and determine if and how such front 
panel changes are reported. 

 
[F1 LO (+/-)] LockOut (+) or do not lockout (-) the front panel.  When lockout is on (+) the front 

panel will display “LOK” or “LLK” in the upper right corner of the display (not 
shown in the MAIN display for a multiposition system).  The user will be able to 
use the left-arrow and right-arrow buttons to move between the settings 
displays (as if no control program were connected) but the up-arrow, down-
arrow and SET buttons will not allow changes in the settings.  The up-arrow and 
down-arrow buttons will work to move between the MAIN SAM, MAIN REF, and 
version/ID displays. 

[F1 LO ?] Query the current lockout state. 
... [F1 LO +] or ...[F1 LO -] 
 
[F1 LK (+/-)] LinK (+) or unlink (-) the reference to/from the sample.  This command is only 

available for a dual sample holder system.  When link is on (+) the front panel 
will display “LNK” or “LKK” in the upper right corner of the display.  The user will 
be unable to change any of the REF settings (they will be locked as described 
above).  When the user changes a “SAM” setting using the front panel controls 
(such as temperature control On/Off, stirrer speed, ramp rate) the identical 
change will automatically be made for “REF’. 

[F1 LK ?] Query the current link state. 
... [F1 LK +] or ...[F1 LK -] 
 
 T-App uses this command to turn linking off in the temperature controller and 

handles linking of the reference settings to the sample settings in the program 
(see link reference to sample). 
 
“LKK” in the upper right corner of the display indicates that both lockout and link 
have been turned on by the control program. 

 
[F1 FP (+/-)] Report (+) or do not report (-) changes made by use of the Front Panel controls on 

the TC 1.  The power-on default is to report FP changes. 
 Setting changes are reported by [F1 TT #], [F1 SS #] and [F1 RR #] replies. 
 The power-on default for status changes is to report by [F1 TC (+/)], [F1 SS (+/)] or 

[F1 RR (+/)] replies, even if the control program has not turned on these status 
change replies.  The control program cannot turn these responses off (except 
as described below). 

 If the control program has sent [F1 IS +] or [F1 IS R+] commands to turn automatic 
instrument status reports on, status changes resulting from use of the front 
panel controls will be reported only by the instrument status reply, [F1 IS ….]. 

 There is no query command for the FP state. 
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12. Elements of the T-App Software Help File 
The program T-App comes with a complete Help File.  This file may be explored in 
detail by locating the file T-App Help.chm and clicking on it to open it.  Below are 
elements from the Help file that are useful for getting started with T-App, if purchased. 

12.1. Application Startup Window 

This Startup Window is displayed while the program searches for a Temperature Controller by checking 
each active COM port on the computer, beginning with the highest. 

 

 

 

When a Controller is found, this startup window is replaced by the Application Control Window. 

 

If a Controller is not found, the startup window changes to that below. Click on the areas where the pointer 
changes to a hand for further information on the Application Menus and buttons, 
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This may result if the Controller is not connected to power, or if the Bluetooth or USB link between the 
Controller and the computer is not available. 

Click the Try Again button (or use the File>Restart menu item) once you have corrected the problem. Click 
the Exit button (or use the File>Exit menu item) to terminate the program. 

You may also use the File>(Work Offline) menu item to use the program without connecting to a sample 
holder in order to plot previously saved time/temperature data without being connected to a Controller. 

12.2. Application Control Window 

Immediately after T-App connects to a Temperature Controller, a banner with blinking text appears across 
the top of the application window as shown below.  This banner persists while T-App is communicating 
(coordinating) with the Controller.  At the end of the coordinating process, T-App causes the Controller to 
begin automatically sending temperatures every 3 seconds. 

The figure below shows the Application Control Window as it would appear if the user changed the sample 
holder Target Temperature from 20 to 37 C while temperature control was on.  The black trace is the sample 
holder temperature and the red trace is the external thermistor probe temperature. 

Click on the areas where the pointer changes to a hand for further information on the Application Menus, the 
Temperature Plot or the Status Panel. 

 

 

 

The image above shows the T-App Application window as it would appear using a TC 1 Temperature 
Controller with a Series 400 thermistor probe attached (with the thermistor tip in the stirred sample).  
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12.3. Application Menus 

Click on the individual menu bar items (where the pointer changes to a hand) for further information on that 
menu. 

 

 

12.4. File Menu 

Click on the individual menu item (where the pointer changes to a hand) for further information on that menu 
item. 

 

 

12.5. Tools Menu 

Click on the individual menu item (where the pointer changes to a hand) for further information on that menu 
item. 

 

Tools menu items for a single sample holder system. 
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Tools menu items for a dual sample holder system. 

 

 

Tools menu items for a multi-position sample holder system. 

 

12.6. Temperature Control 

Tools>(Temperature Control) menu for a single controller, including multi-position controllers. 

 

 

If your system is a dual Temperature Controller with linking turned off, clicking on the "Temperature 
Control" menu item will present two submenu items, "Sample" and "Reference"; clicking on either of these 
submenus will present the three choices for changing settings for that holder (shown for Sample below). 
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Note: If Link Reference to Sample is checked, the Sample/Reference choice will not be available (the 
menu behavior will be identical to a single Controller. 

12.7. Temperature Ramping 

Single sample holder system (including multiple sample position systems). 

 

Dual sample holder system with Reference Linked to Sample. 

 

Dual sample holder system with Reference not linked to Sample. 

 

When you click on one of the Temperature Ramping menu items, a small parameter entry dialog will be 
presented for entry of two parameters. 
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The first parameter determines the temperature at which the ramping process will stop (and will reset the 
Target Temperature to that value). 

The second parameter determines the rate for the temperature ramp (degrees C/min).  This parameter is 
always a positive decimal number and must be greater than or equal to 0.01.  The maximum value is 10.0. 

When the entry dialog is closed (if temperature control is turned on), the sample holder temperature will begin 
to change at the specified rate from the current temperature to the new target temperature.  The direction of 
the ramp (up or down) is determined by these two temperatures. 

If you need to stop the ramp before it is completed, set the ramp rate to zero.  The system will then heat or 
cool at maximum capacity to move the sample holder temperature to the Target Temperature. 

In a dual system, if temperature control is on for both sample and reference then the countdown will not begin 
until both are stable at the target temperature. 

12.8. Stirrer Control 

Single sample holder system (including multiple sample position systems). 

 

 

Dual sample holder system. 

 

Note: If Link Reference to Sample is checked, the Sample/Reference choice will not be available. 
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12.9. Show Script Panel 

 

When this menu item is clicked, the right side of the Application Control Window will open to show a vertical 
panel containing a text display with button controls and other information near the bottom. 

The snapshot below was taken when the program was in the middle of running a script.  This particular script 
is used to do a performance run on each sample holder.  The performance run for each sample holder is 
included in the Calibration Certificate found in the hardware manual. 

 

 

Generally, you should click on the "Clear Display" button before running a script. 

The controls below the text window change depending on whether a delay or wait command is being executed 
and on whether the current command being executed is inside a loop.  Click on the individual control below 
(where the pointer changes to a hand) for further information on that control. 

 

  

NO SCRIPT RUNNING. DELAY/WAIT COMMAND NOT INSIDE A LOOP. 
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CURRENT COMMAND IS INSIDE A LOOP.   DELAY/WAIT COMMAND INSIDE A LOOP. 

12.10. Command Text Box 

This edit box may be used to send commands to the Temperature Controller. 

The edit box content always starts out as "ENTER / SELECT".  When you click on it the first time this content 
is automatically selected, ready to be replaced when a command entered using the keyboard. 

Clicking the arrow at the right end of the edit box will present a drop-down list as shown (below left).  Initially 
the list will include only prototype commands.  Click on the command wanted and it will appear in the edit box 
(below, center).  Change the prototype symbol '±' to a plus or minus; '#' to an appropriate number (below 
right). 

 

To send the command to the QNW Temperature Controller either hit the Enter key on the keyboard (while still 
in the command edit box) or click on the Send Command-> button. 

See the Controller Serial Command List for more information on the serial commands that are available. 

The Listing Control subset of the Program Commands may also be used.  For example, the command [*LCT 
-] tells the program not to display sample holder temperature (CT) replies from the Temperature Controller in 
the multi-line text box. 

New commands can be added to the list.  For example, to insert the command [F1 TT S 37] (above right) 
hold the Shift key down while hitting the Return key (the blinking cursor must be in the edit box).  The 
command will be inserted into the list but will not be sent to the Controller. 

Commands can be removed from the list by selecting the command (so it appears in the edit box) then hold 
the Shift key down while hitting the Delete key. 

12.11. Plot Menu 

Click on the individual menu item (where the pointer changes to a hand) for further information on that menu 
item. 
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12.12. Data Shown 

Dual with external probe 

 

Single (or multi-sample) with external probe 
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12.13. Status Panel 
Click on the individual controls where the pointer changes to a hand for further information on that control. 

Single cuvette holder 
WITHOUT PROBE ATTACHED WITH PROBE ATTACHED  

 
 
Dual cuvette holder 
WITHOUT PROBE ATTACHED WITH PROBE ATTACHED  
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Multi cuvette holder 
WITHOUT PROBE ATTACHED WITH PROBE ATTACHED 

 

12.14. Temperature Control Status 

 

 

   

When temperature control is off, the circle will be a steady gray and the label will read "off". 
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When temperature control is on but the sample holder temperature is not stable, the small circle will alternate 
slowly between green and gray and the label to its right will read "seeking". 

When temperature control is on and the sample holder temperature is stable, the circle will be a steady green 
and the label will read "holding". 

If an error condition occurs that causes temperature control to be turned off the circle and the caption to its 
right will alternate rapidly between red and gray. 

 

12.15. Heat Exchanger Temperature 

 

The temperature of the heat exchanger in the sample holder is displayed here. 

The heat exchanger temperature is dependent on the temperature and the rate of flow of the water being 
circulated through the sample holder and on the temperature control settings. 

As a warning, when the heat exchanger temperature is within 10 °C of the preset limit (typically 60 °C, the 
color of the label will change to orange.  To correct the problem, you must reduce the temperature of the 
water (for example, by adding ice or cold water to the coolant container). 

If the heat exchanger temperature exceeds that preset limit, temperature control will automatically be turned 
off to prevent damage to the system. 

If temperature control does turn off, the label will turn red and an error message will display below the menu 
bar as illustrated below; also, the Temperature Control Status will show the error number and begin flashing 
red. The error message (and the flashing of the status control) can be removed at any time by clicking on the 
Clear button to the left of the message. 

Once the problem with the heat exchanger temperature is corrected, you can restart temperature control by 
clicking on the Temperature Control On/Off checkbox or using the menu item Tools>(Temperature 
Control)>On.  The error screen on the TC 1 will be cleared by restarting temperature control using T-App; 
this screen can also be cleared by pressing the SET button on the front of the TC 1. 
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12.16. Target Temperature 

 

The Target Temperature is the Sample Holder Temperature that you want to use. If Temperature Control is 
On, the Controller will either be driving the holder temperature to the target or maintaining the holder 
temperature at the target. 

The number displayed is the current Target Temperature. When the Change button to the right of the 
number is clicked a small parameter entry dialog will appear where you can change the Target Temperature 
setting. 

The Tools>(Temperature Control)>(Set Target) menu item may also be used to change the Target 
Temperature. 

12.17. Magnetic Stirrer Controls 

 

 

The checkbox may be used to turn the magnetic stirrer on (checked) or off (unchecked). 

Click on the Change button to reset the speed of the stirrer. The current speed setting is shown to the left of 
the button. The submenus of the Tools>(Stirrer Control) menu item may also be used to change the stirrer 
properties. 

12.18. External Probe Status 

The External Probe Status will be displayed only if a Series-400 or Series-500 thermistor probe is connected 
to the 1/4-inch phone jack in the back of the sample holder. This probe input is intended to provide a means 
to directly measure the temperature of the sample in the cuvette. 
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The number to the left of the Avg checkbox is always the most recent temperature from the probe. If a probe 
temperature is not yet available, the digits will be replaced by dashes. 

The left image shows the display for when the Avg box is not checked. 

When the Avg checkbox is checked (by clicking on it), all controller models send probe readings with two 
decimal digits. The numbers in parentheses beneath the checkbox (middle image) list the mean value of the 
most recent 20 temperatures for the probe followed by the average deviation from that mean. The mean 
value should provide a more reproducible sample temperature if it has been stable long enough for 20 
temperatures from the stable period to have been acquired. 

If 20 temperatures are not yet available, the mean and average deviation are replaced by dashes (image on 
the right). 

12.19. Plot Axis Label Manipulation 

The label on the vertical axis can be changed by clicking on the small black rectangle near the upper-left 
corner of the plot; this will make a text box appear for changing the label.  After new text has been entered, 
hitting the Tab or Return key will cause the text box to close and the modified axis label to appear on the 
plot. 

 

 

BEFORE CLICKING ON THE BLACK RECTANGLE.  AFTER CLICKING ON THE BLACK RECTANGLE. 

 

The label on the horizontal axis can be changed by clicking on the small black rectangle near the lower-right 
corner of the plot; this will make a text box appear for changing the label.  After new text has been entered, 
hitting the Tab or Return key will cause the text box to close and the modified axis label to appear on the 
plot. 

 

BEFORE CLICKING ON THE BLACK RECTANGLE. AFTER CLICKING ON THE BLACK RECTANGLE 

12.20. Plot of Data Collected 

This plot shows an example of temperature as a function of time data that would result from using the 
Example Script. 
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black - temperature of the sample holder. blue - temperature of the heat exchanger. 

dotted black - temperature of the external probe (with the thermistor tip in the liquid sample).  

Individual time/temperature points are shown for the external probe data to illustrate special methods of 
reporting probe temperatures used in the Example Script. Normally the probe data are shown as a red line. 

12.21. Scripts: Program Script Commands 

The Program Script Commands are used to control the behavior of a script and are not sent to the QNW 
Temperature Controller. 

Delay and Wait commands 

Progress of the Delay and Wait commands is tracked in the Delay/Wait Countdown Display at the bottom of 
the Script Panel.  

[*D #] -  Delay # INTERVALS before running the next command.  Example: [*D 120] will cause a delay of 120 
of the INTERVAL units as defined in the first line of the script (see the Example Script which sets the 
INTERVAL to 0.01 minutes). 

    While the delay is active, a countdown of the number of script INTERVALs remaining is included in the 
Countdown Display (see Window View 2 in the Script Panel). 

[*WRP>=#] [*WRP<=#] These commands are included to be compatible with older scripts.  T-App now 
interprets them as [*WCT>=#] and [*WCT<=#] 

[*WCT>=#] -  Wait until the current (holder) temperature exceeds or equals a particular value (# as an 
integer). 

[*WCT<=#] -  Wait until the current temperature decreases to or below a particular value (# as an integer). 

    The current temperature is the temperature of the metal body of the sample cuvette holder. 
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[*WPT>=#] -  Wait until the probe temperature exceeds or equals a particular value (# as an integer). 

[*WPT<=#] -  Wait until the probe temperature decreases to or below a particular value (# as an integer). 

    The probe temperature is the reading of the standard 400 series or 500 series probe (usually the probe is 
inserted in the sample cuvette). 

[*WRT>=#] -  Wait until the reference temperature exceeds or equals a particular value (# as an integer). 

[*WRT<=#] -  Wait until the reference temperature decreases to or below a particular value (# as an integer). 

    The reference temperature is the temperature of the metal body of the reference cuvette holder (dual 
Controller only). 

[*WT #] -  This command will be interpreted as a [*WT 1000 1] command to maintain compatibility with older 
script files. 

[*WT (#1) (#2)] -  This program command will cause the script to Wait until the sample holder 

Temperature is stable before continuing to the next script command in the list.  Temperature stability is 
determined by an algorithm built into the QNW Temperature Controller.  The parameter (#1) determines 
how often the program sends a status query to the Controller ( [F1 IS ?], see the Controller Serial Command 
List).  Each time this query is received, the Controller returns a status reply which includes information as to 
whether the temperature is still changing or has met the criteria for being stable (controlled).  The parameter 
(#2) specifies the maximum number of status queries that will be sent before the wait is canceled. 

    The time between status queries is the product of the parameter (#1) and the script INTERVAL as defined 
in the second line of the script (see the Example Script). 

    While the wait is active, the number of times the Controller has been queried is displayed followed by a 
countdown to the next query. 

   Note:  if the command [F1 IS +] has been sent to the Controller, the instrument status reply will be sent by 
the QNW Temperature Controller automatically when the sample holder temperature becomes stable.  In 
this case the command form [*WT (#1) 1] is recommended where (#1) is chosen to give a 10-minute period 
(for example, if INTERVAL IS 0.6 seconds or 0.01 minutes, then (#1) should be set to 1000).  Typically, 
stable sample holder temperature is attained within 10 min of setting a new target temperature.  

[*WD #] -  This command is no longer accepted because it does not work in Windows XP or later. 

  

Beep Control commands 

[*BCT +] or [*BCT-] -  Turn on (+) or off (-) beeping by the computer whenever a sample holder (current) 
temperature report is received from the Controller. 

[*BPT +] or [*BPT-] -  Turn on (+) or off (-) beeping by the computer whenever a probe temperature report is 
received from the Controller. 

[*BRT +] or [*BRT-] -  Turn on (+) or off  (-) beeping by the computer whenever a reference holder 
temperature report is received from the Controller. 

  

Warning Control commands 

[*E+] or [*E-] -  These commands are no longer supported because they are not needed for T-App version 
2.00.  Older scripts that include these commands will still run without generating an error response.  
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Listing Control command 

[*LIS +] or [*LIS -]   -        Enable (+) or Disable (-) listing of Instrument Status replies during running of a 
script. 

[*LER +] or [*LER -] -        Enable (+) or Disable (-) listing of Error Message replies during running of a script. 

[*LCT +] or [*LCT -] -        Enable (+) or Disable (-) listing of Current Temperature replies during running of a 
script. 

[*LPT +] or [*LPT -] -        Enable (+) or Disable (-) listing of Probe Temperature replies during running of a 
script. 

[*LRT +] or [*LRT -] -        Enable (+) or Disable (-) listing of Reference Temperature replies during running of 
a script. 

    These ten program commands can be used to control whether the indicated information, sent from the 
Controller to the program, are to be listed (displayed) in the Script Panel or the Command Panel while a 
script is running.  Disabling the listings may be useful to make progress of the script clearer since, under 
some conditions, large numbers of Instrument Status replies and Temperatures replies may be generated 
while the script is running.  Disabling affects only the listing of these various replies -- the replies will still have 
their normal effects in the Main Window. 

    Note:  some earlier versions of T-App defaulted to listing temperature replies in the Command/Script 
panel.  T-App version 2.00 defaults to not listing them. 

  

Miscellaneous commands 

[*R] -  This program command is used only at the end of a script.  It will cause the script to be repeated, 
starting at the beginning.  The script will then repeat forever or until the Cancel Script button is clicked. 

[*P] -  If the plot window is displayed while a script is running, the data in the plot may not be automatically 
updated unless a delay (*D) or wait (*W) command is being processed.  This program command will cause 
the plot window to update (replot to show all data collected to that point). 

[*CTD]  -  This command will clear the time and temperature data from the Time/Temperature Plot of the 
Application Control Window.  In addition, the time parameter in the displays will be restarted at zero and 
listing of time/temperature data in the display windows will be started.  Whatever display interval was in effect 
at the time this command is executed is retained (set by a script command or by clicking on the (Plot>Set 
Interval) menu item).  

[*MSG + message] or [*MSG - message] - This command will stop execution of the script and present a 
dialog box containing the second command parameter ("message"); change this parameter to the wording 
you want the dialog box to display.  The first parameter (+ or -) determines whether the computer beeps (+) 
or not (-) while the dialog box is visible.  Clicking on the "OK" button in the dialog box closes it and execution 
of the script continues. 

[*LS #] and [*LE] - The [*LS #] command defines the start of a loop (a repeat of a series of commands) 
within the script; the parameter '#' is an integer specifying how many times the loop is to be run.  The [*LE] 
command defines the end of the series of commands included in the loop. A script may contain more than 
one loop.  Also, smaller loops can occur within larger loops. 

[*WPL]   -- When the positioning commands 

       [F2 PL #] = go to position # 

or   [F2 PI]      = go to home and back to the last position 
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are sent to the Temperature Controller, it automatically sends the reply [F2 DL #] when the positioning 
process is completed.  The [*WPL] command waits for this reply before continuing to the next command in 
the script. 

[*PL+] -- This command will cause the sample position to change to the next higher number.  If the current 
position is the highest number position, it will move to position 1. 

[*PL-] -- This command will cause the sample position to change to the next lower number.  If the current 
position is 1, it will move to the highest number position. 

[*TT+#] or [*TT-#] -- Increments or decrements the sample holder target temperature. 

[*RT+#] or [*RT-#] -- Increments or decrements the reference holder target temperature. 
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13. Example Controller Scripts for T-App 
Software 

These scripts and others are provided when the T-App program is purchased from Quantum Northwest.  
They are designed to be used with a TC 1 Temperature Controller connected to a Peltier-based cuvette 
holder.  Each script is a simple text file (.txt) that is read into the T-App program and activated.  Each script is 
easily edited to suit the user’s needs. 

13.1. Controller Scripts for Single Cuvette Holders  
The following are scripts designed for use with single cuvette holders, for example the t2 Sport, Versa 20 and 
Luma 40, with the TC 1 Temperature Controller. 

Script, Step 20 to 50 °C at 1 °C Intervals (TC 1 Controller, t2 Sport Cuvette Holder) 

Controller Script 
Interval = .6 Set the time interval between commands to .6 seconds. 
------------------ 
Initial Setup 
------------------ 
[F1 CT +6] Report current cuvette holder temperature every 6 seconds. 
[F1 PT +6] Report current probe temperature every 6 seconds. 
[F1 HT +6] Report heat exchanger temperature periodically. 
[F1 TT S 20] Set target temperature to 20 deg C 
[F1 TC +] Temperature control on 
[F1 SS S 500] Set stirring to 500 rpm (also turns stirring on) 
[*CTD]  Clear time/temperature data and reset time to zero 
------------------ 
Step up to 50 C, 1 C intervals: 
------------------ 
[*LS 32] Start loop 
   [*WT 1000 2] Wait for stable temperature (or 20 min maximum) 
   [*D 600] Wait 6 min for sample equilibration 
  Notify user, with beeping. 
   [*MSG + Ready (note T and make measurement)]  
   [*TT+1] Increase target T by 1C 
[*LE] 
------------------ 
Clean-up 
------------------ 
[F1 CT -] Stop periodic sample holder temperature reporting. 
[F1 PT -] Stop periodic probe temperature reporting. 
[F1 HT -] Stop periodic heat exchanger temperature reporting. 
[F1 TC -] Temperature control off 
[F1 SS -] Stirring off 
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Script, Ramp 20 to 50 °C at 1 °C per minute (TC 1 Controller, t2 Sport Cuvette Holder) 

Controller Script 
Interval = .6 Set the time interval between commands to .6 seconds. 
------------------ 
Initial Setup 
------------------ 
[F1 CT +6] Report current cuvette holder temperature every 6 seconds. 
[F1 PT +6] Report current probe temperature every 6 seconds. 
[F1 HT +6] Report heat exchanger temperature periodically. 
[F1 TT S 20] Set target temperature to 20 deg C 
[F1 TC +] Temperature control on 
[F1 SS S 500] Set stirring to 500 rpm (also turns stirring on) 
[*WT 1000 2] Wait for stable temperature (or 20 min maximum) 
[*D 600] Wait 6 min for sample equilibration 
------------------ 
Ramp up to 50: 
------------------ 
[F1 RR S 1] Set Ramp rate to 1 deg C. 
[F1 TT S 50.00] Set Target Temperature to 50.00 deg C, to start ramping process. 
[*CTD]  Clear time/temperature data and reset time to zero 
[*WCT>=50] Wait until the sample holder temperature reaches 50.00 deg C. 
------------------ 
Clean-up 
------------------ 
[F1 PT -] Stop periodic probe temperature reporting. 
[F1 CT -] Stop periodic sample holder temperature reporting. 
[F1 HT -] Stop periodic heat exchanger temperature reporting. 
[F1 TC -] Temperature control off 
[F1 SS -] Stirring off 
[*MSG + Script run is complete] Notify user, with beeping. 
 

Script, Performance Run (TC 1 Controller, t2 Sport Cuvette Holder, with External Probe) 

Controller Script 
Interval = .6 sec (0.01 min)    time interval between commands 
[F1 CT +5]  Report sample holder temperature periodically. 
[F1 PT +5]  Report probe temperature periodically. 
[F1 TC +]  Turn on Temperature Control 
[F1 TT S 20.00]  Set Target Temperature to 20 C 
[*D=1500]  Wait 15 minutes 
[F1 TT S 50.00]  Set 50 C Target 
[*D=2000]  Wait 20 minutes 
[F1 TT S 0.00]  Set 0 C Target 
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[*D=2500]  Wait 25 minutes 
[F1 TT S -15.00] Set -15 C Target 
[*D=3000]  Wait 30 minutes 
[F1 TT S 80.00]  Set 80 C Target 
[*D=3000]  Wait 30 minutes 
[F1 TT S 20.00]  Set 20 C Target 
[*D=2500]  Wait 25 minutes 
[F1 PT -]  Stop periodic probe temperature reporting. 
[F1 CT -]  Stop periodic sample holder temperature reporting. 
[F1 TC -]  Turn off sample Temperature Control 
 

Script, Multiple Ramp (TC 1 Controller, t2 Sport Cuvette Holder, no External Probe) 

Controller Script 
Interval = 1.2 Set the time interval between commands to 1.2 seconds (0.02 min). 
------------------ 
Initial Setup 
------------------ 
[F1 TC +] Turn on Temperature Controls. 
[F1 TT S 10] Set Target Temperature to 10 deg C. 
[F1 SS S 500] Set Stirrer Speeds to 500 rpm (turns stirrers on). 
[F1 CT +10] Report sample cuvette holder temperature periodically. 
[F1 HT +10] Report heat exchanger temperature periodically. 
[*CTD]  Clear time/temperature displays and reset time to zero 
[*MSG - This script requires pre-equilibration to 10 C.  Close this message (click OK).  Then, when 
equilibrated, click on the "End Wait" button (lower right corner of window).] 
[*D=1500] Wait 30 minutes or until user clicks the "End Wait" button. 
[*CTD]  Clear time/temperature displays and reset time to zero 
[*D=250] Collect temperatures for 5 minutes. 
------------------ 
First Ramp to 40 at 4 degC/min: 
------------------ 
[F1 RR S 4.0] Set Ramping Rate to 4 deg/min. 
[*BPT +] Turn on the option for computer to beep each time a probe temperature report is received. 
[F1 TT S 40] Set Target Temperature to 40 deg C, to start ramping process. 
[*WCT>=40] Wait until the sample temperature reaches 40 deg C. 
------------------ 
Second Ramp to 45 at 0.2 degC/min: 
------------------ 
[F1 RR S 0.2] Set Ramping Rate to 0.2 deg/min. 
[F1 TT S 45] Set Target Temperature to 45 deg C to start ramping process. 
[*WCT>=45] Wait until the sample temperature reaches 45 deg C. 
------------------ 
Third Ramp to 80: 
------------------ 
[F1 RR S 4.0] Set Ramping rate to 4 deg/min. 
[F1 TT S 80.00] Set Target Temperature to 80.00 deg C to start ramping process. 
[*D 100] Wait 2 min before changing probe temperatures spacing. 
[*WCT>=80] Wait until the sample temperature reaches 80 deg C. 
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[*BPT -] Turn off the computer beep each time a probe temperature report is received. 
[*D 500] Wait 10 min to allow temperatures to stabilize. 
------------------ 
Ramp back to 20: 
------------------ 
[F1 RR S 2.5] Ramping rate to 2.5 deg C per minute. 
[F1 TT S 20] Set Target Temperature to 20 deg C to start ramping process. 
[*WCT<=20] Wait until the sample temperature reaches 20 deg C. 
[*D 150] Hold 3 minutes to allow the probe temperature to catch up. 
------------------ 
Clean up 
------------------ 
[*D 350] Wait another 7 minutes for final equilibration. 
[F1 CT -] Stop periodic sample holder temperature reporting. 
[F1 HT -] Stop periodic heat exchanger temperature reporting. 
[F1 TC -] Temperature control off 
[F1 SS -] Stirring off 
[*MSG + The multiramp script run is complete] Notify user, with beeping. 

13.2. Controller Scripts for Dual Cuvette Holders  
The following are scripts designed for use with dual cuvette holders, for example the t2x2 Sport, with the TC 
1 Temperature Controller. 

Script, Step 20 to 50 °C at 1 °C Intervals (TC 1 Controller, t2x2 Sport Dual Cuvette Holder) 

Controller Script 
Interval = .6 Set the time interval between commands to .6 seconds. 
------------------ 
Initial Setup 
------------------ 
[F1 CT +6] Report current cuvette holder temperature every 6 seconds. 
[F1 PT +6] Report current probe temperature every 6 seconds. 
[R1 CT +6] Report reference cuvette holder temperature periodically. 
[F1 HT +6] Report heat exchanger temperature periodically. 
[R1 HT +6] Report reference heat exchanger temperature periodically. 
[F1 TT S 20] Set target temperatures to 20 deg C 
[R1 TT S 20] Set target temperature to 20 deg C 
[F1 TC +] Temperature controls on 
[R1 TC +] 
[F1 SS S 500] Set stirring to 500 rpm (also turns stirring on) 
[R1 SS S 500] 
[*CTD] Clear time/temperature data and reset time to zero 
------------------ 
Step up to 50 C, 1 C intervals: 
------------------ 
[*LS 32] Start loop 
   [*WT 1000 2] Wait for stable temperature (or 20 min maximum) 
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   [*D 600] Wait 6 min for sample equilibration 
  Notify user, with beeping. 
   [*MSG + Ready (note T and make measurement)]  
   [*TT+1] Increase target T by 1C 
   [*RT+1] 
[*LE] 
------------------ 
Clean-up 
------------------ 
[F1 CT -] Stop periodic sample holder temperature reporting. 
[F1 PT -] Stop periodic probe temperature reporting. 
[F1 HT -] Stop periodic heat exchanger temperature reporting. 
[R1 CT -] Stop periodic reference holder temperature reporting. 
[R1 HT -] Stop periodic reference exchanger temperature reporting. 
[F1 TC -] Temperature controls off 
[R1 TC -] 
[F1 SS -] Stirring off 
[R1 SS -] 

Script, Ramp 20 to 50 °C at 1 °C per minute (TC 1 Controller, t2x2 Sport Dual Cuvette 
Holder) 

Controller Script 
Interval = .6 Set the time interval between commands to .6 seconds. 
------------------ 
Initial Setup 
------------------ 
[F1 CT +6] Report current cuvette holder temperature every 6 seconds. 
[R1 CT +6] Report reference cuvette holder temperature periodically. 
[F1 HT +6] Report heat exchanger temperature periodically. 
[R1 HT +6] Report reference heat exchanger temperature periodically. 
[F1 TT S 20] Set target temperatures to 20 deg C 
[R1 TT S 20] 
[F1 TC +] Temperature controls on 
[R1 TC +] 
[F1 SS S 500] Set stirring to 500 rpm (also turns stirring on) 
[R1 SS S 500] 
[*WT 1000 2] Wait for stable temperature (or 20 min maximum) 
[*D 600] Wait 6 min for sample equilibration 
------------------ 
Ramp up to 50: 
------------------ 
[F1 RR S 1] Set Ramp rates to 1 deg C. 
[R1 RR S 1] 
[F1 TT S 50.00] Set Target Temperatures to 50.00 deg C to start ramping process. 
[R1 TT S 50.00] 
[*CTD]  Clear time/temperature data and reset time to zero 
[*WCT>=50] Wait until the sample holder temperature reaches 50.00 deg C. 
------------------ 
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Clean-up 
------------------ 
[F1 CT -] Stop periodic sample holder temperature reporting. 
[F1 HT -] Stop periodic heat exchanger temperature reporting. 
[R1 CT -] Stop periodic reference holder temperature reporting. 
[R1 HT -] Stop periodic reference exchanger temperature reporting. 
[F1 TC -] Temperature controls off 
[R1 TC -] 
[F1 SS -] Stirring off 
[R1 SS -] 
[*MSG + Script run is complete] Notify user, with beeping. 

Script, Performance Run (TC 1 Controller, t2x2 Sport Dual Cuvette Holder, with External 
Probe) 

Controller Script 
Interval = .6 sec (0.01 min)    time interval between commands 
[F1 CT +5]  Report sample holder temperature periodically. 
[R1 CT +5]  Report reference holder temperature periodically. 
[F1 PT +5]  Report probe temperature periodically. 
[F1 TC +]  Turn on sample Temperature Control 
[R1 TC +]  Turn on reference Temperature Control 
[F1 TT S 20.00]  Set sample Target Temperature to 20 C 
[R1 TT S 20.00]  Set reference Target Temperature to 20 C 
[*D=1500]  Wait 15 minutes 
[F1 TT S 50.00]  Set sample 50 C Target 
[R1 TT S 50.00]  Set reference 50 C Target 
[*D=2000]  Wait 20 minutes 
[F1 TT S 0.00]  Set sample 0 C Target 
[R1 TT S 0.00]  Set reference 0 C Target 
[*D=2500]  Wait 25 minutes 
[F1 TT S -15.00] Set sample -15 C Target 
[R1 TT S -15.00] Set reference -15 C Target 
[*D=3000]  Wait 30 minutes 
[F1 TT S 80.00]  Set sample 80 C Target 
[R1 TT S 80.00]  Set reference 80 C Target 
[*D=3000]  Wait 30 minutes 
[F1 TT S 20.00]  Set sample 20 C Target 
[R1 TT S 20.00]  Set reference 20 C Target 
[*D=2500]  Wait 25 minutes 
[F1 PT -]  Stop periodic probe temperature reporting. 
[F1 CT -]  Stop periodic sample holder temperature reporting. 
[R1 CT -]  Stop periodic reference holder temperature reporting 
[F1 TC -]  Turn off sample Temperature Control 
[R1 TC -]  Turn off reference Temperature Control 
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Script, Multiple Ramp (TC 1 Controller, t2x2 Sport Dual Cuvette Holder, no External 
Probe) 

Controller Script 
Interval = 0.6 Set the time interval between commands to 0.6 seconds (0.01 min). 
------------------ 
Initial Setup 
------------------ 
[F1 TC +] Turn on Temperature Controls. 
[R1 TC +] 
[F1 TT S 10] Set Target Temperatures to 10 deg C. 
[R1 TT S 10] 
[F1 SS S 500] Set Stirrer Speeds to 500 rpm (turns stirrers on). 
[R1 SS S 500] 
[F1 CT +10] Report sample cuvette holder temperature periodically. 
[F1 HT +10] Report heat exchanger temperature periodically. 
[R1 CT +10] Report reference cuvette holder temperature periodically. 
[R1 HT +10] Report reference heat exchanger temperature periodically. 
[*CTD]  Clear time/temperature displays and reset time to zero 
[*MSG - This script requires pre-equilibration to 10 C.  Close this message (click OK).  Then, when 
equilibrated, click on the "End Wait" button (lower right corner of window).] 
[*D=3000]       Wait 30 minutes or until user clicks the "End Wait" button. 
[*CTD]  Clear time/temperature displays and reset time to zero 
[*D=500] Collect temperatures for 5 minutes. 
------------------ 
First Ramp to 40 at 4 degC/min: 
------------------ 
[F1 RR S 4.0] Set Ramp Rates to 4 deg/min. 
[R1 RR S 4.0] 
[F1 TT S 40] Set Target Temperatures to 40 deg C, to start ramping process. 
[R1 TT S 40] 
[*WCT>=40] Wait until the sample temperature reaches 40 deg C. 
------------------ 
Second Ramp to 45 at 0.2 degC/min: 
------------------ 
[F1 RR S 0.2] Set Ramp Rates to 0.2 deg/min. 
[R1 RR S 0.2] 
[F1 TT S 45] Set Target Temperatures to 45 deg C to start ramping process. 
[R1 TT S 45] 
[*WCT>=45] Wait until the sample temperature reaches 45 deg C. 
------------------ 
Third Ramp to 80: 
------------------ 
[F1 RR S 4.0] Set Ramp rates to 4 deg/min. 
[R1 RR S 4.0] 
[F1 TT S 80.00] Set Target Temperatures to 80.00 deg C to start ramping process. 
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[R1 TT S 80.00] 
[*WCT>=80] Wait until the sample temperature reaches 80 deg C. 
[*D 1000] Wait 10 min to allow temperatures to stabilize. 
------------------ 
Ramp back to 20: 
------------------ 
[F1 RR S 2.5] Ramp rates to 2.5 deg C per minute. 
[R1 RR S 2.5] 
[F1 TT S 20] Set Target Temperatures to 20 deg C to start ramping process. 
[R1 TT S 20] 
[*WCT<=20] Wait until the sample temperature reaches 20 deg C. 
[*D 1000] Wait 10 minutes. 
------------------ 
Clean up 
------------------ 
[F1 CT -] Stop periodic sample holder temperature reporting. 
[F1 HT -] Stop periodic heat exchanger temperature reporting. 
[R1 CT -] Stop periodic reference holder temperature reporting. 
[R1 HT -] Stop periodic reference exchanger temperature reporting. 
[F1 TC -] Temperature control off 
[R1 TC -] 
[F1 SS -] Stirring off 
[R1 SS -] 
[*MSG + The multiramp script run is complete] Notify user, with beeping. 
 

13.3. Controller Scripts for Multiple-Cell Cuvette Holders  
The following are scripts designed for use with multiple cuvette holders, for example the qCHANGER 6, 
Turret 4 and Turret 6, with the TC 1 Temperature Controller. 

Script, Move Any Multi‐Cell Cuvette Holder (TC 1 Controller) 

Controller Script 
Interval = .6  (0.01 min) 
This script will only work with T-App 1.50 or later 
[F2 PL 1] go to position 1 
[*WPL]  wait for position change 
[*D 50]  wait 30 seconds 
[*LS 50]  loop 50 times 
   [*LS 6] loop 6 times 
      [*PL+] move to next position 
      [*WPL] wait for position change 
      [*D 50] wait 30 seconds 
   [*LE]  end of loop 6 times 
[*LE]  end of loop 50 times 
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Script, Move the Turret 4 Four‐Position Cuvette Holder (TC 1 Controller) 

Controller Script 
Interval = .6  (0.01 min) 
This script will work with any T-App 
[F2 PL 1] go to position 1 
[*D 50]  wait 30 seconds 
[F2 PL 2] go to position 2 
[*D 50]  wait 30 seconds 
[F2 PL 3] go to position 3 
[*D 50]  wait 30 seconds 
[F2 PL 4] go to position 4 
[*D 50]  wait 30 seconds 
[*R]  repeat from the beginning 

Script, Move the Turret 6 or qCHANGER 6 Six‐Position Cuvette Holder (TC 1 Controller) 

Controller Script 
Interval = .6  (0.01 min) 
This script will work with any T-App 
[F2 PL 1] go to position 1 
[*D 50]  wait 30 seconds 
[F2 PL 2] go to position 2 
[*D 50]  wait 30 seconds 
[F2 PL 3] go to position 3 
[*D 50]  wait 30 seconds 
[F2 PL 4] go to position 4 
[*D 50]  wait 30 seconds 
[F2 PL 5] go to position 5 
[*D 50]  wait 30 seconds 
[F2 PL 6] go to position 6 
[*D 50]  wait 30 seconds 
[*R]  repeat from the beginning 


